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安全にご使用いただくために

安全にご使用いただくために

人体への損傷を避け、本製品や本製品に接続されている製品への損傷を防止するために、次の安全性に
関する注意をよくお読みください。

安全にご使用いただくために、本製品の指示に従ってください。

資格のあるサービス担当者以外は、保守点検手順を実行しないでください。

火災や人体への損傷を避けるには

適切な電源コードを使用してください。 本製品用に指定され、使用される国で認定された電源コードの
みを使用してください。

本製品を接地してください。 本製品は、電源コードのグランド線を使用して接地します。 感電を避けるた
め、グランド線をアースに接続する必要があります。 本製品の入出力端子に接続する前に、製品が正しく接
地されていることを確認してください。

すべての端子の定格に従ってください。 火災や感電の危険を避けるために、本製品のすべての定格と
マーキングに従ってください。 本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参
照してください。

共通端子を含むどの端子にも、その端子の 大定格を超える電位をかけないでください。

電源を切断してください。 電源コードの取り外しによって主電源が切り離されます。電源コードをさえぎら
ないでください。このコードは常にアクセス可能であることが必要です。

カバーを外した状態で動作させないでください。 カバーやパネルを外した状態で本製品を動作させな
いでください。

故障の疑いがあるときは動作させないでください。 本製品に故障の疑いがある場合、資格のあるサー
ビス担当者に検査してもらってください。

露出した回路への接触は避けてください。 電源がオンのときに、露出した接続部分やコンポーネントに
触れないでください。

湿気の多いところでは動作させないでください。

爆発性のあるガスがある場所では使用しないでください。

製品の表面を清潔で乾燥した状態に保ってください。

適切に通気してください。 適切な通気が得られるような製品の設置方法の詳細については、マニュアル
の設置方法を参照してください。
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本マニュアル内の用語

本マニュアルでは、次の用語を使用します。

警告： 人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意： 本製品やその他の接続機器に損害を与える状態や行為を示します。

本製品に関する記号と用語

本製品では、次の用語を使用します。

DANGER: ただちに人体や生命に危険をおよぼす可能性があることを示します。

WARNING: 人体や生命に危険をおよぼす可能性があることを示します。

CAUTION: 本製品を含む周辺機器に損傷を与える可能性があることを示します。

本製品では、次の記号を使用します。
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適合性に関する情報

適合性に関する情報

このセクションでは、本製品が準拠する EMC (electromagnetic compliance)、安全性、および環境基準につ
いて説明します。

EMC 適合性

EC 適合宣言 (EMC)

指令 2004/108/EC 電磁環境両立性に適合します。「Official Journal of the European Communities」 にリスト
されている次の仕様に準拠します。

EN 61326-1 2006: 測定、制御、および実験用途の電子装置に対する EMC 基準 1 2 3

CISPR 11:2003. 放射性および伝導性エミッション、グループ 1、クラス A

IEC 61000-4-2:2001. 静電気放電イミュニティ

IEC 61000-4-3:2002. 電磁界イミュニティ

IEC 61000-4-4:2004. ファスト・トランジェント／バースト・イミュニティ

IEC 61000-4-5:2001. 電源サージ・イミュニティ

IEC 61000-4-6:2003. 伝導 RF イミュニティ

IEC 61000-4-11:2004. 電圧低下と遮断イミュニティ

EN 61000-3-2:2006: AC 電源高調波エミッション

EN 61000-3-3:1995: 電圧の変化、変動、およびフリッカ

欧州域内連絡先:

Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 この製品は、住居区域以外での使用を意図しています。住居区域で使用すると、電磁干渉の原因となることがあります。

2 この装置をテスト対象に接続した状態では、この規格が要求するレベルを超えるエミッションが発生する可能性があります。

3 ここに挙げた各種 EMC 規格への適合を確認するには、高品質なシールドを持つインタフェース・ケーブルが必要です。
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オーストラリア／ニュージーランド適合宣言 (EMC)

ACMA に従い、次の規格に準拠することで Radiocommunications Act の EMC 条項に適合しています。

CISPR 11:2003： 放射性および伝導性エミッション、グループ 1、クラス A、EN 61326-1:2006 に準拠

安全性

EC 適合宣言(低電圧指令）

Official Journal of the European Communities に記載されている次の基準に準拠します。

低電圧指令 2006/95/EC

EN 61010-1:2001: 測定、制御および実験用途の電子装置に対する安全基準

米国の国家認定試験機関のリスト

UL 61010-1:2004, 2nd Edition: 電子計測機器の規格

カナダ認証

CAN/CSA C22.2 No.61010-1:2004: 測定、制御、および研究用途の電子装置に対する安全基準、第 1
部

その他の適合性

IEC 61010-1:2001: 測定、制御、および実験用途の電子装置に対する安全基準

機器の種類

測定機器

安全クラス

Class 1:アース付き製品

汚染度の説明

製品内およびその周辺で発生する可能性がある汚染の尺度です。通常、製品の内部環境は外部環境と同
じとみなされます。製品は、その製品に指定されている環境でのみ使用してください。

汚染度 1: 汚染なし、または乾燥した非導電性の汚染のみが発生します。このカテゴリの製品は、通常、
被包性、密封性のあるものか、クリーン・ルームにあるものです。

汚染度 2: 通常、乾燥した非導電性の汚染のみが発生します。ただし、まれに結露によって一時的な導
電性が発生することは避けられません。これは、標準的なオフィスや家庭環境で発生します。一時的な
結露は、製品非動作時にだけ発生します。
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汚染度 3: 導電性のある汚染、または結露のために導電性のある汚染となる乾燥した非導電性の汚染。
温度、湿度のいずれも管理されていない屋内で発生します。日光、雨、風に対する直接の曝露からは保
護されている領域です。

汚染度 4: 導電性のある塵、雨、または雪により持続的に導電性が生じている汚染。一般的に屋外です。

汚染度

汚染度 2 （IEC 61010-1 の定義による）。注: 屋内使用のみについての評価です。

環境に関する考慮事項
このセクションでは、製品の環境に対する影響について説明します。

製品の廃棄方法

機器またはコンポーネントをリサイクルする際には、次のガイドラインを遵守してください。

機器のリサイクル: 本機器を生産する際には、天然資源が使用されています。本機器には、製品を廃棄する
際に適切に処理されなかった場合に、環境または人体に有害となる物質が含まれています。有害物質の放出
を防ぎ、天然資源の使用を減らすため、機材の大部分を再利用またはリサイクルで きるように本製品を正しくリ
サイクルしてください。

左に示すシンボルは、この製品が WEEE (Waste Electrical and Electronic Equipment) Directive
2002/96/EC （廃棄電気・電子 機器に関する指令）、および 2006/66/EC （新電池指令） に基
づく EU の諸要件に準拠していることを示しています。リサ イクル方法については、Tektronix
のウェブ・サイト （www.tektronix.com） のサポート / サービスの項目を参照してください。

水銀に関する通知: この製品に使用されている LCD バックライト・ランプには、水銀が含まれています。
廃棄にあたっては、環境への配慮が必要です。廃棄およびリサイクルに関しては、お住まいの地域の関係
官庁等にお尋ねください。

1 AWG5000C または AWG7000C シリーズの機器には、水銀に関する通知は適用されません。

過塩素酸塩の取り扱い: 本製品は CR リチウム・コイン・バッテリを含んでいます。カリフォルニア州の
規制によると、CR リチウム・コインは過塩素酸塩に分類され、特別の取り扱いが要求されます。詳細は
www.dtsc.ca.gov/hazardouswaste/perchlorate を参照してください。

有害物質に関する規制

この製品は Monitoring and Control （監視および制御） 装置に分類され、2002/95/EC RoHS Directive （電
気・電子機器含有特定危険物質使用制限指令） の適用範囲外です。
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はじめに

本マニュアルでは、AWG5000 および AWG7000 シリーズ任意波形ゼネレータの設置と操作方法について
説明します。基本的な操作方法や概念について主に記述されます。詳細については、機器のオンライン・
ヘルプを参照してください。本マニュアルは、次の機器を対象としています。

AWG7000C シリーズ： AWG7122C 型、AWG7082C 型

AWG5000C シリーズ： AWG5002C 型、AWG5012C 型、AWG5014C 型

AWG7000B シリーズ： AWG7121B 型、AWG7122B 型、AWG7061B 型、AWG7062B 型

AWG5000B シリーズ： AWG5012B 型、AWG5014B 型、AWG5002B 型、AWG5004B 型

主な機能
AWG5000 および AWG7000 シリーズの主な機能は次のとおりです。

Microsoft Windows 7 Professional オペレーティング・システム（AWG5000C および AWG7000C シリーズ）

Microsoft Windows XP Professional オペレーティング・システム（AWG5000B および AWG7000B シリーズ）

広帯域アナログ出力（オプション 02型、オプション 06 型）

28 ビット・デジタル・データ出力（AWG5002B 型、AWG5012B 型、AWG5002C 型、および AWG5012C 型
のみ、オプション 03 型）

インターリーブおよび広帯域アナログ出力（AWG7122B 型、AWG7122C 型、および AWG7082C 型の
み、オプション 06 型）

高速シーケンス切替（AWG5000B シリーズ、AWG7000B シリーズ、および AWG7000C シリーズのみ、オ
プション 08 型）

大型 10.4 インチ (264.2 mm) 高分解能 XGA カラー・ディスプレイ

オンライン・ヘルプを内蔵した直感的なグラフィカル・ユーザ・インタフェース

リムーバブル・ハード・ディスク・ドライブ（オプション 05 型）

USB 2.0 インタフェースをサポート

LAN (1000/100/10 Base-T)

タッチ・スクリーン・インタフェース

表 i: AWG5000Cおよび AWG7000C シリーズの機能

型名
AWG7122C

型
AWG7082C

型
AWG5014C

型 AWG5012C 型
AWG5002C

型

大サンプリ
ング・レート

12 GS/s（イン
ターリーブで
は 24 GS/s）

8 GS/s （ イン
ターリーブで
は 16 GS/s）

1.2 GS/s 1.2 GS/s 600 MS/s

D/A 分解能 8 ビットまたは 10 ビット（切替可
能）

14 ビット

波形長 32 M または 64 M（オプション 01
型）

16 M または 32 M（オプション 01 型）
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表 i: AWG5000Cおよび AWG7000C シリーズの機能 （続き）

型名
AWG7122C

型
AWG7082C

型
AWG5014C

型 AWG5012C 型
AWG5002C

型

アナログ出力 2 2 4 2 2

マーカ出力 4 4 8 4 4

大アナログ
振幅

2 Vpp（標準モデル）
1 Vpp（オプション 06 型）

4.5 VPP

大振幅およ
びアナログ帯
域

2 Vp-p、750 MHz（通常モード）
1 Vp-p、3.5 GHz（ダイレクト D/A
モード）
1 Vpp、7.5 GHz（オプション 06型、
1 CH モード）

2 Vp-p、250 MHz（通常モード）
0.6 Vp-p、370 MHz（ダイレクト D/A モード）

デジタル・デー
タ出力

不可 不可 不可 28 ビット（オプ
ション 03 型）

28 ビット（オプ
ション 03 型）

表 ii: AWG5000B および AWG7000B シリーズの機能

型名
AWG7121B/
AWG7122B

AWG7061B/
AWG7062B

AWG5012B/
AWG5014B

AWG5002B/
AWG5004B

大サンプリング・
レート

12 GS/s（インター
リ ー ブ で は 24
GS/s）

6 GS/s 1.2 GS/s 600 MS/s

D/A 分解能 8 ビットまたは 10 ビット（切替可能） 14 ビット

波形長 32 M または 64 M（オプション 01 型） 16 M または 32 M（オプション 01 型）

アナログ出力 1 または 2 2 または 4

大アナログ振幅 2 Vpp（標準モデル）
1 Vpp（オプション 06 型）

4.5 VPP

大振幅およびア
ナログ帯域

2 Vp-p、750 MHz（通常モード）
1 Vp-p、3.5 GHz（ダイレクト D/A モード）
1 Vp-p, 7.5 GHz （オプション 02 または
オプション 06）

2 Vp-p、250 MHz（通常モード）
0.6 Vp-p、370 MHz（ダイレクト D/A モー
ド）

マーカ出力 1 2 または 4 4 または 8

デジタル・データ
出力

不可 28 ビット（オプション 03 型）

1 AWG7000 シリーズで 10 ビット分解能選択時には、マーカ出力は使用できません
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マニュアル
本製品に関する各種情報の参照先は以下のとおりです。

参照する項目 使用するドキュメント

インストレーション、操作概要 機器の操作とユーザ・インタフェース・コントロールに関する一般
的な内容については、「クイック・スタート・ユー ザ・マニュアル」
を参照してください。

操作方法の詳細とユーザ・インタフェー
スに関するヘルプ

前面パネル・コントロールやスクリーン・インタフェースに関する
詳しい説明は、Help メニューからユーザ・オンライン・ヘルプに
アクセスします。オンライン・ヘルプには、機 器の諸機能の使用
方法が記載されています。

プログラマ・ヘルプ Help メニューからプログラマ・オンライン・ヘルプを選択します。
プログラマ・ヘルプでリモート・コマンドのシンタックスを簡単に参
照できます。

性能の確認と仕様 仕様および性能検査手順については、テクニカル・リファレンス・
マニュアルを参照してください。これらのマニュアルはドキュメン
ト CD に収録されています。

サービス手順 モジュール・レベルの機器の点検については、当社 Web サイト
（www.tektronix.com/manuals）のサービス・マニュアルを参照して
ください。

本マニュアルの表記規則
このマニュアルでは次のアイコンを使用しています。

手順 前面パネル
電源

電源の接続 ネットワーク PS2 SVGA USB
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機器のインストール

機器のインストール

機器を開梱し、スタンダード・アクセサリとして記載されているすべての付属品が含まれていることを確認しま
す。 新の情報については、当社 Web サイト（www.tektronix.com）を参照してください。

注： 機器には製品ソフトウェアの CD は同梱されていません。製品ソフトウェアを再インストールする場合
は、当社 Web サイトから機器の 新版のソフトウェアをダウンロードしてください。

スタンダード・アクセサリ

アクセサリ Tektronix 部品番号

AWG5000B および AWG7000B シリーズクイック・スタート・ユーザ・マ
ニュアル

英語( オプション L0) 071-2481-xx

日本語(オプション L5） 071-2482-xx

簡体中国語( オプション L7) 071-2483-xx

繁体中国語( オプション L8) 071-2484-xx

ロシア語( オプション L10) 020-2971-xx

ドキュメント CD 063-4134-xx

ユーザ・オンライン・ヘルプ ( プロダクト・ソフトウェアの一部) ---

プログラマ・オンライン・ヘルプ( プロダクト・ソフトウェアの一部) ---

キーボード (Windows 互換) 119-7083-xx

マウス (Windows 互換) 119-7054-xx

DC 出力用リードセット 012-1697-xx

前面パネル・カバー 200-4963-xx

アクセサリ・ポーチ 016-1441-xx

50 Ω SMA ターミネーション、オス、DC ～ 18 GHz（各 3 個）
（AWG7000 シリーズのみ）

015-1022-xx

電源コード(以下のいずれかが付属)

北米 ( オプション A0)

欧州 ( オプション A1)

英国 ( オプション A2)

オーストラリア ( オプション A3)

スイス ( オプション A5)

日本 ( オプション A6)

中国 ( オプション A10)

インド ( オプション A11)

電源コードまたは AC アダプ
タなし ( オプション A99)
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機器のインストール

動作の要件

注意： 排気が確実に行われるように、機器の両側に障害物を置かないでください。

次の設置条件を満たす空間を確保して、カートまたはベンチに設置します。

上部：20 mm（0.8 インチ）

左側および右側：150 mm（5.9 インチ）

底部：20 mm（0.8 インチ）

後部：75 mm（3 インチ）

環境要件

機器を使用する前に、機器が 20 分間ウォーム・アップされていることと、以下の表の環境要件を満たしているこ
とを確認してください。

要件 説明

温度（動作時） 10 ℃ ～ 40 ℃（+50 ﾟF ～ +104 ﾟF）

相対湿度（動作時） 30 ℃（86 ﾟF）以下で相対湿度 5% ～ 95%

30 ℃（86 ﾟF）超 40 ℃（104 ﾟF）以下では 5% ～ 45%
の相対湿度、結露なし。 高湿球温度 29 ℃（84.2
ﾟF）

高度（動作時） 3,000 m（約 10,000 フィート）まで

電源の要件

警告： 出火および感電のリスクを減らすため、主電源の電圧変動が動作電圧レンジの 10% を超えていな
いことを確認してください。

電源電圧と周波 消費電力

100 VAC ～ 240 VAC、 47 Hz ～ 63 Hz 450 W 未満 (AWG7000 シリーズ)

560 W 未満 (AWG5000 シリーズ)

クリーニング

警告： 人体への損傷を避けるために、以下の手順を実行する前に、機器の電源をオフにして電源コード
を取り外します。
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機器のインストール

任意波形ゼネレータの使用環境に応じて機器の検査を行ってください。機器表面のクリーニングは次の手
順を実行します。

1. 乾いた柔らかい布で機器の表面に付着した塵を落とします。前面パネルのディスプレイを傷つけないよ
うに注意してください

2. 水で湿らせた柔らかい布を使用して機器の汚れを落とします。75% イソプロピル・アルコール水溶剤を使
用してください。

注意： 研磨剤や化学洗浄剤は使用しないでください。本機器の表面を傷つけるおそれがあります。

機器の電源をオンにする

1. 機器の後部パネルに AC 電源コー
ドを接続します。

2. 前面パネルのパワー・ボタンを押し
て、機器の電源をオンにします。

注： 機器を使用する前に、システムのバックアップとして、オペレーティング・システムのリストア・ディスク・
セットを作成してください。機器にはオペレーティング・システムのリストア用メディアは同梱されていません。
オペレーティング・システムのリストア・ディスクの作成については、次の指示を参照してください。 (11 ペー
ジ 「オペレーティング・システムのリストア・ディスクの作成」 参照)。
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機器のインストール

機器の電源をオフにする

1. 前面パネルのパワー・ボタンを押し
て、機器をシャットダウンします。

パワー・ボタンを押してから電源が
切れるまで約 30 秒かかります。

2. 機器の電源を完全にオフにするに
は、シャットダウン実行後、電源コー
ドを取り外します。

Windows インタフェース・ガイドライン
本機器は Microsoft 社の Windows インタフェースを使用していますので、Excel、WordPad や Paint などの
Windows ベースのアプリケーションにアクセスできます。

機器の操作に悪影響を及ぼすおそれがありますので、オペレーティング・システムを変更することは避けて
ください。以下のガイドラインに従ってください。

Control Panel の内容を変更するときは十分に注意してください。専門知識のない場合は、Control Panel
の内容を変更しないでください。

システム・フォントを削除したり、変更したりしないでください。本機器の表示に影響を及ぼすおそれが
あります。

Background、Appearance、Effects、Settings など、システムの表示プロパティを変更しないでください。機
器の操作性やタッチ・スクリーンに影響を及ぼすおそれがあります。

Windows フォルダや Program Files\Tektronix\AWG\System フォルダの内容を変更しないでください。

BIOS の設定を変更しないでください。BIOS 設定を変更すると、機器全体の動作に影響を及ぼします。

Windows インタフェースの動作により機器に障害が発生していると思われる場合は、Tektronix のサポート・
センターまでご連絡ください。
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機器のインストール

ネットワークへの接続
本機器をネットワークに接続して、印刷、ファイル共有、インターネット・アクセスなどの機能を利用できます。
ネットワークに対して機器を設定するには、ネットワーク管理者に問い合わせ、標準の Windows ユーティリ
ティを使用してください。GPIB、LAN の設定には、System メニューの GPIB/LAN Configuration ダイアログ・
ボックスを使用します。

GPIB/LAN の設定

System > GPIB/LAN Configuration を
選択すると、ダイアログ・ボックスが表示
されます。

1. 機器の GPIB バス・コミュニケーショ
ンを設定します。

Talk/Listen – 外部ホスト・コン
ピュータから機器をリモート・コ
ントロールします。

Off Bus – 機器と GPIB バス間が
切断されます。

2. 本機器は、VXI-11 Server の LAN
接続をサポートします。VXI-11
Server のスタート/ ストップは、タス
ク・トレイの VXI-11 Server Control
を使用してください。

3. TCP/IP プロトコルもサポートされま
す。ソケット通信のオン / オフはこ
こでコントロールします。ポート番号
は 4000 に固定されます。

ヒント

電源投入時に自動的に VXI-11 Server をスタートさせたい場合は、VXI-11 Server Control の “Start
server automatically at system powerup” をチェックしてください。

以下の操作は GPIB 又は LAN 接続からは実行できません。

波形編集

波形のサイズ、名前の変更

波形のフォーマット変換

AWG5000 シリーズ/AWG7000 シリーズ設定ファイル （*.AWG） からの波形データのインポート

Tektronix DTG5000 シリーズのファイル・インポート

Tektronix AWG400/500/600/700 シリーズ SEQ ファイルのインポート

波形データのエクスポート
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機器のインストール

リモート PC を利用した機器のコントロール
Windows の Remote Desktop 機能を利用することで、LAN を経由して、お使いの PC を利用して任意波形
ゼネレータをコントロールできます。PC のスクリーンが本機器よりも大きい場合、キーボートとマウスを利用し
てより効率的な編集作業を行えます。また、PC にインストールされているサードパーティ・ソフトウェアを使っ
て波形を作成し、それをネットワーク経由でインポートすることもできます。

オフライン・モード
オフライン・モードとは、本機器のアプリケーションをお使いの PC 上で実行させる機能です。アプリケーショ
ンを PC にインストールしてください。機器の本体ハードウェアは不要です。機器の設定ファイルの作成およ
び編集が可能です。PC で作成したファイルをのちほど本機器で使用できます。

1. 当 社 の Web サ イ ト （ www.tek-
tronix.com/software）で AWG 製品
ソフトウェアの 新バージョンをダ
ウンロードします。指示に従って、
AWG アプリケーションを PC にイン
ストールしてください。

2. オフライン・モードを使用する前に、
機器のコンフィグレーションを設定
する必要があります。

Windows の Start メニューから、
All Programs > Tektronix > AWG
> AWG Config Utility を選択して
Configuration Utility ダイアログ・ボッ
クスを表示します。

3. ご使用の機器のタイプを選択しま
す。

4. ご使用の機器のオプション設定を
指定します。

5. OK をクリックします。

Start メニューから機器のアプリケー
ションを起動すると、Configuration
Utility の設定内容が反映されます。
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機器のインストール

機器の検査
機器の機能を確認するために、2 種類の診断ルーチンが用意されています。

パワーオン・セルフテスト – 本機器は、電源投入時にセルフテストを実行します。

System メニューからの診断実行 – 以下の手順を実行します。

1. メニュー・バーから System > Diag-
nostics... を選択します。

Diagnostics ダイアログ・ボックスが
表示されます。

2. Loop がチェックされていないことを
確認します。

Loop がチェックされていると、手動
で停止されるまで診断が繰り返され
ます。

3. Select All をクリックすると、全項目
がチェックされます。

全項目の診断をまとめて実行する
ことも、選択した項目のみの診断を
実行することもできます。

4. Execute をクリックすると、診断が実
行されます。

エラーが報告されないことを確認し
ます。エラーが報告された場合は、
Tektronix のサービスまでご連絡く
ださい。
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機器のインストール

自己校正
自己校正は、内部診断ルーチンによりアナログ・レベルやマーカ・レベル等の電気的特性をチェックし、必
要に応じ内部校正定数を調整します。マーカ・レベルは AWG7000 シリーズのみチェックされます。

注： 本手順を実行する前に、機器の電源を入れ 20 分間オンのままにしておきます。

1. 前面パネルの Run ボタンがオフの
状態であることを確認して、信号が
出力されていないことを確認します。

2. 校正を実行するには、メニュー・バー
から System > Calibration... を選択
します。

Calibration ダイアログ・ボックスが表
示されます。

3. Execute を選択します。

4. 出力コネクタに接続されているケー
ブルを取り外すことを要求するダイ
アログ・ボックスが表示されます。

5. ケーブルを取り外し、OK を押しま
す。校正が終了するまで待ちます。

エラーが報告されないことを確認し
ます。エラーが報告された場合は、
Tektronix のサービスまでご連絡く
ださい。

注： 自己校正は有効な温度条件下でないと正しく行われません。(2 ページ 「動作の要件」 参照)。

注： AWG7000 シリーズ – アナログおよびマーカの出力レベルの確度を維持するために、１ ヶ月に １ 度自
己校正を実行してください。実行しない場合、アナログおよびマーカ出力に関して保証されている性能レベ
ルを満たさないことがあります。

AWG5000 シリーズ – アナログ出力レベルの確度を維持するために、1 年に1 度自己校正を実行してくだ
さい。
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機器のインストール

機器の損傷防止

過熱保護機能

本機器は過熱検出機能を持ち、機器の内部温度がモニタされます。過熱状態を検出すると、次の動作が実
行されます。

機器内部温度がしきい値を超えると警告メッセージが表示されます。

機器の温度がさらに上昇すると、本機器は自動的にシャットダウンします。

警告メッセージが表示されたか、又は機器がシャットダウンした場合、次の条件をチェックしてください。
(2 ページ 「動作の要件」 参照)。

機器が所定の温度範囲で使用されている。

所定の設置条件 （ クリアランス ） を満足している。

機器のファンが正しく動作している。

出力コネクタ

本機器の前面パネルには、信号出力用のコネクタと入力用のコネクタが用意されています。信号出力用コ
ネクタに外部からの信号を加えないでください。

注意： 信号出力コネクタにケーブルを接続または取り外す場合は、必ず任意波形ゼネレータの信号出力
をオフにしてください。信号出力がオンの状態で外部機器 (DUT) を接続すると、本機器や DUT に損傷を
与えることがあります。

AWG5000 および AWG7000 シリーズ・クイック・スタート・ユーザ・マニュアル 9



機器のインストール

オプションのインストール
Option Installation ダイアログ・ボックスを使用して、Tektronix から購入したオプション機器を有効にできます。

新のオプションのリストについては、www.tektronix.com またはTektronix 代理店にお問い合わせください。

1. System > Option Installation... を選
択すると、ダイアログ・ボックスが表
示されます。

2. Continue をクリックすると、2 つ目
のダイアログ・ボックスが表示されま
す。

Tektronix から提供されるオプショ
ン・インストレーション・キーを入力し
て、スクリーンに表示される指示に
従い、オプションをインストールしま
す。

注： オプション・キー入力後、実際にオプションを使用可能な状態にするには、アプリケーションを再起動
する必要があります。
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オペレーティング・システムのリストア・ディスクの作成

オペレーティング・システムのリストア・ディスクの作成

本機器にはリストア・ディスクは付属していません。次の手順に従って、一連のディスクを作成し、必要な場
合にオペレーティング・システムをリストアできるようにしてください。

注意： オペレーティング・システムをリストアすると、ハード・ディスク・ドライブは再フォーマットされます。ISO
イメージを含めユーザ・データは失われます（Acronis Recovery パーティションおよび関連するデータは破
棄されません）。オペレーティング・システムのリストアを試みる前に、オペレーティング・システム・リストア・
ディスクを作成してください。

注： この手順では、Microsoft Windows オペレーティング・システムの、一連のリストア・ディスクを作成しま
す。オペレーティング・システムをリストアした後で、機器のアプリケーション・ソフトウェアを再インストールし
ます。当社の Web サイト（www.tektronix.com/software）でアプリケーション・ソフトウェアをダウンロードし、指
示に従って再インストールしてください。

リストア・ディスクの作成
準備: 次のものを用意します。

DVD±R/W ドライブおよび CD 書込みソフトウェア付きのコンピュータ。

本機器からコンピュータに ISO イメージ・ファイルを転送するための USB フラッシュ・ドライブ（8 GB 以
上）、または LAN 環境。

DVD-R（DVD-R/W 不可）ディスク、約 2 枚（バックアップ・ファイルの数により異なります）。

一連のリストア CD-ROM を作成するには、次の手順を実行します。

1. 機器上で、C:\backup フォルダに移動します。

2. USB フラッシュ・ドライブまたは LAN を使用して、restoreN.iso という名前の各ファイルをコンピュータ（CD
書き込み機能付き）に転送します。

3. DVD 書き込みソフトウェアを使用して、バックアップ用 ISO イメージ・ファイル（restore1.iso～restoreN.iso）
を DVD に書き込みます。各 DVD のラベルにはバックアップ・ファイル名、機器の名称とシリアル番号、
および日付を記入します。

4. OS のリストア・ディスクの書き込みが終了したら、バックアップ用にディスク・イメージ・ファイル（*.iso）を
ネットワーク上の適切な場所、別のハード・ディスク、光メディアなどにコピーしておきます。（機器の OS
をリストアすると、機器のハード・ディスク上の ISO イメージは消去されます）。

5. バックアップ・ディスクは社内規定 に従って保管してください。

注： リストア用ディスクは、ディスク作成時に使用した機器でのみ有効です。
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オペレーティング・システムのリストア・ディスクの作成

オペレーティング・システムをリストアする
機器のオペレーティング・システムのリストアは、機器のハード・ディスク・ドライブのファイルか、またはその
機器の一連のリストア・ディスクから行います。 (11 ページ 「リストア・ディスクの作成」 参照)。

注意： オペレーティング・システムをリストアすると、ハード・ディスク・ドライブは再フォーマットされます。ISO
イメージを含めユーザ・データは失われます（Acronis Recovery パーティションおよび関連するデータは破
棄されません）。

リストア・ディスクからのオペレーティング・システムのリストア

注： この手順を実行するには、DVD ドライブが、 初に起動するデバイスとして設定されている必要があり
ます（デフォルトの設定）。

注： リストア用ディスクは、ディスク作成時に使用した機器でのみ有効です。

1. リストア・ディスク 1 を機器の DVD ドライブに挿入します。

2. 機器を再起動します。DVD ドライブが 初のブート・デバイスであれば、リストア・ソフトウェアが自動的に
起動します。DVD ドライブが 初のブート・デバイスでない場合は、ディスクからのリストアを実行する前
に、 初のブート・デバイスとして設定する必要があります。

3. Restore をクリックします。

4. 確認のダイアログ・ボックス内で Yes をクリックしてオペレーティング・システムをリストアします。または No
を選択するとリストア・プロセスを終了します。

5. 表示されるメッセージに従って現在のリストア・ディスクを取り出し、要求されたディスクを挿入します。こ
れをリストア・プロセスが完了するまで繰り返します。

注： リストア・プロセスの途中、プログレス・バーが動かなくなることがあります。しかし、ディスク・ドライブのラ
ンプが点滅し続けていれば、リストア・プロセスは進行しています。

注： リストア・セッションの初めと終わりに、リストア・アプリケーションがセットの 初と 後のディスクを繰り返
し挿入するよう要求してきます。これはリストア・アプリケーションの正常な動作です。

6. リストア・プロセスが完了したら、 後のリストア・ディスクを取り出して、機器を再起動します。

7. AWG アプリケーション・ソフトウェアをインストールします。まだソフトウェアをダウンロードしていない場
合は、当社 Web サイト（www.tektronix.com/software）でソフトウェアをダウンロードし、指示に従って機器
にソフトウェアをインストールしてください。
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オペレーティング・システムのリストア・ディスクの作成

機器のハード・ディスクからオペレーティング・システムをリストアする

本機器では、ハード・ドライブの別のパーティションにオペレーティング・システム・リストア用ファイルが含ま
れています。

1. 機器を再起動します。ブートアップの途中で次のメッセージがスクリーンに表示されます。

Starting Acronis Loader… press F5 for Acronis Startup Recovery Manager

2. Acronis True Image Tool が開くまで F5 キーを繰り返し押します。メッセージが表示されてから起動する
までに約 5 秒間かかります。Acronis アプリケーションが開かなかった場合は、機器の電源をオフにして
から再度オンにして、もう一度やり直してください。

3. Restore をクリックします。

4. 確認のダイアログ・ボックスで Yes をクリックして機器のオペレーティング・システムをリストアするか、No
をクリックしてリストア・プロセスを終了します。リストア・プロセスには約 10 分ほどを要しますが、実際にか
かる時間は機器の設定によって異なります。

5. AWG アプリケーション・ソフトウェアをインストールします。まだソフトウェアをダウンロードしていない場
合は、当社 Web サイト（www.tektronix.com/software）でソフトウェアをダウンロードし、指示に従って機器
にソフトウェアをインストールしてください。
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前面パネル

前面パネル

次の図は、AWG7000 シリーズの機器のフロント・パネルを示しています。AWG5000 シリーズの機器も同様
です。

前面パネル・コネクタ

コネクタ 説明

1. Interleave Output インタリーブ・コネクタは、12 GS/s ～ 24 GS/s レンジのアナログ
信号を出力します（AWG7000C シリーズのオプション 06 型、お
よび AWG7122B 型のオプション 06 型のみ）。AWG7082C 型の
オプション 06 型では、8 GS/s ～ 16 GS/s のレンジとなります。
コネクタ・タイプ: SMA

2. Analog Output アナログ信号を出力します。
コネクタ・タイプ: SMA (AWG7000 シリーズ)
コネクタ・タイプ: BNC (AWG5000 シリーズ)

3. Marker Output マーカ信号を出力します。
コネクタ・タイプ: SMA (AWG7000 シリーズ)
コネクタ・タイプ: BNC (AWG5000 シリーズ)

4. Trigger Input 外部トリガ信号を入力できます。
コネクタ・タイプ: BNC

5. Event Input イベント信号を入力できます。
コネクタ・タイプ: BNC

6. USB 2 つの USB コネクタが前面パネルに装備されています。
USB デバイスを接続できます。

7. DC Output 4つの DC 電圧を出力します。
コネクタ・タイプ: 2.54 mm 2 x 4 ピン・ヘッダ ( メス)
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リア・パネル（AWG7000C シリーズ）

注意： 信号出力コネクタにケーブルを接続または取り外す場合は、必ず任意波形ゼネレータの信号出力
をオフにしてください。信号出力がオンの状態で外部機器 (DUT) を接続すると、本機器や DUT に損傷を
与えることがあります。

リア・パネル（AWG7000C シリーズ）

注： AWG7000B シリーズの場合は、異なる位置に同様のコネクタがあります。

コネクタ 説明

1. 取り外し可能な HDD 取り外し可能なハード・ディスク・ドライブ。HDD を取り外すと、
セットアップ・ファイルや波形データなどのユーザ情報は機器内
部には残りません。

2. TekLink データ・インポート用 TekLink コネクタ

3. GPIB 機器と GPIB コントローラを接続する GPIB コネクタ

4. PS-2 マウス用コネクタ マウスを機器に接続する PS-2 コネクタ

5. COM2 他のデバイスをシリアル・ポート経由で接続するときに使用する
COM2 シリアル・ポート

6. eSATA ポート 外部の SATA デバイスを機器に接続するときに使用する eSATA
ポート

7. 同期クロック出力ポート 同期クロック出力ポートは、同期信号を他の外部デバイスに送信
するために使用します。不使用時はこのコネクタを終端してくだ
さい。

8. LAN 機器をネットワークに接続する RJ-45 コネクタ
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リア・パネル（AWG7000C シリーズ）

コネクタ 説明

9. PS-2 キーボード・コネクタ PS-2 キーボードを機器に接続する PS-2 コネクタ

10.COM1 他の機器をシリアル・ポート経由で接続するときに使用する COM1
シリアル・ポート

11. ビデオ 拡張デスクトップ操作用のモニタの接続に使用する DVI-I ビデオ・
ポート。VGA モニタを DVI-I コネクタに接続するには、VGA-DVI
アダプタを使用します。

12.USB USB デバイスを接続します。

13.ダイナミック・ジャンプ・イン・コネクタ 15 ピンの DSUB コネクタを使用して、テーブル・ジャンプとそれ
に伴う操作の際に素早い切り替えを可能にします。（AWG7000C
シリーズ）

14.External Clock Input オシレータ入力用コネクタ
コネクタ・タイプ：SMA

15.Reference Clock Input 外部リファレンス・クロック入力用コネクタ
コネクタ・タイプ：BNC

16.10MHz Reference Output 10MHz リファレンス・クロック信号出力コネクタ
コネクタ・タイプ：BNC
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リア・パネル（AWG7000C シリーズ）

ダイナミック・ジャンプ・イン・コネクタ（AWG7000C シリーズ）
AWG7000C シリーズの機器の場合、リア・パネルにダイナミック・ジャンプ・イン・コネクタがあり、0.0 V ～ +5.0
V （DC + ピーク AC）の TTL レベル信号を受け入れます。15 ピン・タイプの D コネクタを使用して、ジャン
プ・イン信号を機器に接続します。機器は 1 本のストローブ信号と 8 本のジャンプ・イン信号を受け入れま
す。次の図と表は、このコネクタのピン接続を示しています。

ピン番号 信号 方向

1 GND

2 ジャンプ・ビット 0 入力

3 ジャンプ・ビット 1 入力

4 ジャンプ・ビット 2 入力

5 ジャンプ・ビット 3 入力

6 GND

7 ストローブ 入力

8 GND

9 GND

10 ジャンプ・ビット 4 入力

11 ジャンプ・ビット 5 入力

12 ジャンプ・ビット 6 入力

13 ジャンプ・ビット 7 入力

14 GND

15 GND
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リア・パネル（AWG5000C シリーズ）

リア・パネル（AWG5000C シリーズ）

注： AWG5000B シリーズの場合は、異なる位置に同様のコネクタがあります。

コネクタ 説明

1. 取り外し可能な HDD 取り外し可能なハード・ディスク・ドライブ。HDD を取り外すと、セットアッ
プ・ファイルや波形データなどのユーザ情報は機器内部には残りません。

2. TekLink データのインポートや、オプション 09 型の TTL イベントを TekLink LVDS
コネクタ・アダプタ・ボックスに接続する TekLink コネクタ

3. GPIB GPIB の操作のために機器と GPIB コントローラを接続する GPIB コネクタ

4. PS-2 マウス用コネクタ マウスを機器に接続する PS-2 コネクタ

5. COM2 他のデバイスをシリアル・ポート経由で接続するときに使用する COM2 シ
リアル・ポート

6. eSATA ポート 外部の SATA デバイスを機器に接続するときに使用する eSATA ポート

7. LAN 機器をネットワークに接続する RJ-45 コネクタ

8. PS-2 キーボード・コネクタ PS-2 キーボードを機器に接続する PS-2 コネクタ

9. COM1 他の機器をシリアル・ポート経由で接続するときに使用する COM1 シリア
ル・ポート

10. ビデオ 拡張デスクトップ操作用のモニタの接続に使用する DVI-I ビデオ・ポート。
VGA モニタを DVI-I コネクタに接続するには、VGA-DVI アダプタを使用
します。

11.USB USB デバイスを接続します。
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リア・パネル（AWG5000C シリーズ）

コネクタ 説明

12.Digital Data Out デジタル・データの出力用コネクタ。デジタル・データ出力を行うには、
AWG5002C 型、AWG5012C 型、AWG5002B 型、AWG5012B 型にオプショ
ン 03 型をインストールする必要があります。
コネクタ・タイプ：SMB

13.Add Input 機器の出力信号に外部信号を付加
コネクタ・タイプ：BNC

14.External Clock Input オシレータ入力用コネクタ
コネクタ・タイプ：BNC

15.Oscillator Output オシレータ出力用コネクタ
コネクタ・タイプ：BNC

16.Reference Clock Input 外部リファレンス・クロック入力用コネクタ
コネクタ・タイプ：BNC

17.10MHz Reference Output 10 MHz リファレンス・クロック信号出力コネクタ
コネクタ・タイプ：BNC
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機器の概要

機器の概要

コントロール・パネル

ボタン / キ- 説明

1. Run Run ボタンは信号発生動作の開始 / 停止をコントロールします。
信号が発生しているときは LED が点灯します。
実際に出力コネクタから信号を出力させるには、前面パネルの
All Outputs On/Off ボタン、または Channel Output On ボタンを
押して出力をイネーブルにする必要があります。

2. All Outputs On/Off ひとつ以上の出力がオンのときにこのボタンを押すと、すべての
出力がオフになります。すべての出力がオフのときにこのボタン
を押すと、すべての出力がオンになります。

3. Channel Output On チャンネル出力のオン / オフを切り替えます。出力がオンの状態
のとき LED が点灯します。

4. Channel Select チャンネル選択ボタンは、操作の対象となるチャンネルを選択す
るのに使用します。前面パネルのチャンネル選択ボタンが押され
ると、Settings ウィンドウの対応するチャンネルのページがアクティ
ブになります。

5. File – Open/Save Open または Save ボタンが押されると、対応するダイアログ・ボッ
クスが表示され、設定ファイル (*.AWG) をロードまたは保存がで
きます。
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機器の概要

ボタン / キ- 説明

6. Factory Default このボタンを押すと指定されたデフォルト設定が呼び出されます。
(47 ページ 「デフォルト設定」 参照)。

7. Sampling Rate このボタンを押すと Settings ウィンドウで Timing ページのサンプ
リング・レートのパラメータが選択されます。サンプリング・レートは
各チャンネルに共通です。

8. Level – Amplitude/Offset このボタンを押すと Settings ウィンドウで該当するチャンネルの
Amplitude または Offset のパラメータが選択されます。
振幅は各チャンネルで個別に設定できます。

9. Marker 1 お よ び Marker 2 –
High/Low

このボタンを押すと Settings ウィンドウで該当するチャンネルの
Marker High または Marker Low のパラメータが選択されます。
Marker High と Marker Low は各チャンネルで個別に設定できま
す。

10.Touch Screen Off タッチスクリーン機能がオンの状態のとき、指先やスタイラス・ペン
等を使用してスクリーン・インタフェースをコントロールできます。
タッチ・スクリーンがオフのとき、LED が点灯します。

11.Force Trigger このボタンを押すと、内部トリガ信号を発生します。

12.Force Event このボタンを押すと、内部イベント信号を発生します。

13.汎用ノブ このノブは、設定値を増減させたり、ポップアップ・メニュー、プル
ダウン・メニュー、またはダイアログ・ボックスでアイテムを選択す
るのに使用されます。ノブを時計回りに回すと値が増加し、反時
計回りに回すと値が減少します。

14.桁選択キー 桁選択矢印キーは、編集フィールドで数字を変更するときの桁移
動に使用します。数字を変更するにはノブを使用します。

15.数値入力キ- 数値入力後に単位用接頭語キー （T/p、G/n、M/μ、k/m） を押
すと、Enter キーを押すことなく値を確定できます。
周波数の場合は T （テラ）、G （ギガ）、M （メガ）、k （キロ） と解
釈されます。時間の場合は p （ピコ）、n （ナノ）、μ （マイクロ）、
m （ ミリ） と解釈されます。

注意： 前面パネルの信号出力コネクタに外部機器 (DUT) を接続するときは、必ず本機器の信号出力をオ
フにしてください。

本機器の信号出力がオンの状態では、外部機器の電源オン / オフを行わないでください。

前面パネル・コントロールのロック / ロック解除
任意波形ゼネレータの前面パネルは、GPIB や Ethernet でリモート操作されている間にロックされる場合があ
ります。前面パネルがロックされていると電源スイッチを除くすべてのキーやボタンは使用できなくなります。
マウスやキーボードも使用できません。ただし、前面パネルがロック状態 でも Windows の操作は可能です。

前面パネル・コントロールのロックを解除するには、リモート・コマンドを使用するか、または前面パネルの
Cancel ボタンを 2 回続けて押します。アプリケーションを終了するとロック状態は解除されます。再びアプリ
ケーションを起動した場合、前面パネルはロック解除されています。

AWG5000 および AWG7000 シリーズ・クイック・スタート・ユーザ・マニュアル 21



機器の概要

タッチ・スクリーン・インタフェース
任意波形ゼネレータでは、メニュー選択のために 2 つの方法が用意されています。

前面パネル・コントロール、キーボード、およびマウス

前面パネル・コントロールとタッチ・スクリーン・インタフェース

1. 前面パネルの Touch Screen ボタン
を押すことにより、タッチ・スクリーン
機能のオンとオフを切り替えられま
す。

オフの状態で LED が点灯します。
この状態でもスクリーンのメニューに
はマウスまたはキーボードでアクセ
スできます。

ヒント

デスクトップの Calibrate Touchscreen アイコンをクリックして、タッチ・スクリーンを調整できます。 (22 ページ
「Elo Touchscreen アプリケーション」 参照)。 以下のようなときに、タッチ・スクリーンを調整する必要が生じ
ます。

オペレーティング・システムを再インストールする

ハード・ディスク・ドライブを交換する

タッチ・スクリーンが適切に反応しない

Elo Touchscreen アプリケーション
タッチ・スクリーンに何らかの問題が発生した場合、まず Elo Touchscreen アプリケーションから、タッチ・スク
リーンが正しく選択されているかどうか確認してください。以下の手順で、正しい選択に戻すことができます。

1. Windows スタート・メニューから、Control Panel を選択します。

2. コントロール・パネルの、Elo Touchscreen アイコンをダブルクリックします。

3. Properties 1 タブ、Advanced ボタンの順にクリックします。

4. Edge Acceleration ツールで、Enable Edge Acceleration が選択されているかどうか確認します。

5. OK をクリックします。

6. Mode タブをクリックします。

7. Calibration モードで、Enhanced が選択されているかどうか確認します。

8. OK をクリックしてコントロール・パネルを閉じます。

9. デスクトップの Calibrate Touchscreen アイコンをクリックして、再度タッチスクリーンを調整します。
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機器の概要

スクリーン・インタフェース

スクリーンのエレメント 説明

1. メニュー・バー メニュー・バーから機器のすべての機能にアクセスできます。

2. ステータス・バー ステータス・バーは、サンプリング・レート、動作モード、出力ス
テータスなどの機器情報を表示します。

3. Waveform List ウィンドウ Waveform List にはユーザ定義波形とあらかじめ定義された波形
のリストがあります。

4. Sequence ウィンドウ このウィンドウは、主にシーケンスに関する情報を表示します。

5. Waveform ウィンドウ このウィンドウには、Waveform List または Sequence ウィンドウで
選択された波形が表示されます。

6. Settings ウィンドウ このウィンドウは、パラメータ設定へのクイック・アクセスとして用
意されています。

7. ウィンドウ・タグ タグをクリックすると、対応するウィンドウの表示 / 非表示を切り
替えます。

8. リモート・コマンド・バー 現在の機器操作に対応するリモート・コマンドが表示されます。
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機器の概要

任意波形ゼネレータ操作の基本ステップ
機器の電源投入後、アプリケーションのメニュー・バーやコントロール・ウィンドウを使用して波形の作成およ
び編集を行います。(26 ページ 「メニューおよびコントロール・ウィンドウへのアクセス」 参照)。 以下のステッ
プに従って波形を出力します。

1. 新しいアナログ波形を作成するに
は、Edit > Create Analog Waveform
を選択します。作成された波形が
Waveform List ウィンドウに表示され
ます。

2. 既存の波形を使用するには、File
> Open File... で設定ファイルを開
き、Waveform List ウィンドウに登録
してある波形を選択します。

3. 動作モードを確認します。Settings
ウィンドウの Run Mode ページで、
希望する動作モードが選択されて
いることを確認します。

4. 信号を発生させるには、前面パネ
ルの Run ボタン、またはステータス・
バーの Run ボタンを押します。

5. 次のいずれかを使用して、チャンネ
ルの出力をオンにします。

前面パネルの Channel Output
On ボタンまたは All Outputs
On/Off ボタン

Settings ウィンドウ Ch ページの
Output On ボタン
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機器の概要

Run モード
任意波形ゼネレータは以下の動作モードをサポートします。

連続(Continuous): 連続した波形が出力されます。

トリガ(Triggered): トリガ信号を受信したときに 1 つの波形を出力します。波形を出力した後は、次のトリ
ガ信号待ちの状態になります。

ゲート(Gated): ゲート信号が有効な状態のときのみ波形が出力されます。ゲート信号が有効な間は連続
した波形が出力されます。

シーケンス(Sequence): シーケンスで定義された順序に従って複数の波形が出力されます。

Run モードは、Settings ウィンドウの Run Mode ページで選択します。

1. 動作モードを選択します。

2. トリガ・モードとゲート・モードでは、
トリガ待ちの状態での出力値を選択
できます。

First – 出力レベルとして波形の
初の値を指定します。

Last – 出力レベルとして波形の
後の値を指定します。
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機器の概要

Trigger コントロール

トリガは、動作モードがトリガ、ゲート、シーケンスのときに、波形出力の制御を行います。トリガのパラメータは、
Settings ウィンドウの Trigger ページで設定します。

1. トリガ・ソース (Internal または Ex-
ternal) を選択できます。デフォルト
は External です。

2. External を選択すると、トリガ・レベ
ル、トリガ・スロープ、トリガ・インピー
ダンスを設定できます。

Level – 外部トリガのトリガ・レベ
ルを設定します。

Slope – 外部トリガを使用する
とき、立上り (Positive)、立下り
(Negative) のどちらのエッジでト
リガをかけるかを指定します。

Impedance – 外部トリガのイン
ピーダンスを指定します （1 kΩ
または 50 Ω）。

3. Internal を選択すると、内部トリガの
トリガ間隔が設定できます。

ヒント

トリガのパラメータが、信号出力動作をコントロールします。トリガのパラメータは、動作モードが Continuous
のときは設定できません。

トリガ・ソースで選択した信号のほかに、前面パネルの Force Trigger ボタンを押してもトリガを発生する
ことができます。

メニューおよびコントロール・ウィンドウへのアクセス
各メニューのコマンドやコントロール・ウィンドウにアクセスするために、さまざまな手段が用意されています。

1. メニュー・バーから Settings をクリッ
クして、コマンドを選択します。

選択した項目が Settings ウィンドウ
でアクティブになります。
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2. 設定メニューへのショートカットとし
て、Settings ウィンドウを使用できま
す。

Settings ウィンドウで Ch 1 や Timing
のタブをクリックすると、対応する
ページが表示されます。機器の各
種設定を選択するのに使用します。

3. 前面パネルから、サンプリング・レー
ト、振幅レベル、オフセット・レベル、
およびマーカ・レベルの各パラメー
タ設定にすばやくアクセスできます。

これらのボタンの 1 つを押すと
Settings ウィンドウの対応するパラ
メータが選択されます。

4. マウスの右クリックで関連するメ
ニュー項目に簡単にアクセスでき
ます。

たとえば、Waveform List ウィンドウ
上で右クリックすると、関連するメ
ニューが表示されます。
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コントロール設定を変更する
機器を設定するときに、振幅レベルやオフセットなどの数値パラメータを設定する必要があります。スクリー
ン・ウィンドウでこれらのパラメータを設定するには、タッチするかクリックしてそのパラメータを選択します。
いったん選択すると、そのパラメータに対して汎用ノブが有効になります。

コントロール設定を変更するときには、汎用ノブを使用できますが、以下に述べる方法によっても設定を変更す
ることができます。

一部のパラメータには、ポップアッ
プ・キーパッドまたはキーボードで
値を入力できるものもあります。

キーパッド （またはキーボード） アイ
コンをクリックすると、キーパッド （ま
たはキーボード） が表示されます。

パラメータを選択するには、そのパ
ラメータに触れるかクリックします。
下線を任意の桁に移動し、桁選択
キーを使用してその桁の値を変更
します。
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コントロール・ウィンドウの表示切替
任意波形ゼネレータのスクリーンには、デフォルトで 4 つのコントロール・ウィンドウが表示されます。ウィンド
ウ・タグを使用して、各ウィンドウの表示/ 非表示をすばやく切り替えることができます。

1. 動作モードがシーケンスの場合、デ
フォルトでは、4 つのウィンドウすべ
てが表示されます。

2. Settings タグをクリックします。

3. Settings ウィンドウが非表示となりま
す。
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ステータス・バー
ステータス・バーは 2 つの機能を持ちます。サンプリング・レート、Run ステート、動作モードなどの機器のス
テータスを表示します。さらに、Force Trigger、Force Event、All Outputs On/Off、および Run ボタンが配置
されています。これらのボタンをクリックすると、それぞれのアクションが実行されます。

1. Sampling Rate サンプリング・レートが表示されます。

2. Run Status 機器の動作状態 （Running または Stopped） が表示されます。

3. Run Mode 現在の動作モードが表示されます。

4. Force Trigger ボタン 前面パネルの Force Trigger ボタンと同じ機能です。

5. Force Event ボタン 前面パネルの Force Event ボタンと同じ機能です。

6. All Outputs On/Off ボタン 前面パネルの All Outputs On/Off ボタンと同じ機能です。

7. Run ボタン 前面パネルの Run ボタンと同じ機能です。
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スクリーン表示のユーザ設定

System > Preferences... を選択すると、
ダイアログ・ボックスが表示されます。

1. Startup – 電源投入時に呼び出され
る設定を選択できます。(48 ページ
「電源投入時の設定を変更する」 参
照)。

2. LCD Brightness – LCD の輝度を設
定します。

3. Fit to Window Based On – ズーム・
フィット時の垂直軸スケール設定を
選択します。

H/W Output Range – 垂直軸の
スケールが機器の出力可能範
囲により決まります。

Waveform Data – 波形データを
もとに垂直軸のスケールが決ま
ります。

4. Hold – シーケンス・モード以外で、
有効な波形長が変更されたとき、次
のどちらのパラメータを保持するか
を指定します。

Sampling Rate

Repetition Rate

5. Remote Command Log – 本機器で
使用される GPIB コマンドのシーケ
ンスを記録しておくことができます。
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ウィンドウの表示スタイルを変更する
View メニューの Display Properties ダイアログ・ボックスを使用して、Waveform ウィンドウおよび Sequence ウィ
ンドウの表示方法を設定できます。

Waveform ウィンドウ

1. View > Display Properties... を選択
すると、ダイアログ・ボックスが表示
されます。

Waveform Window タブをクリックしま
す。

2. Waveform ウィンドウの表示フォー
マットとして (Graphic または Table)
を選択できます。

3. この例は Graphic 表示です。View
は Analog に固定されます。Overlay
と Grid のオン/ オフを選択できま
す。

4. Overlay を選択すると、複数のチャ
ンネルのアナログ・データが重なっ
て表示されます。

5. 表示波形のラインの太さを選択でき
ます。

6. 垂直軸の単位を選択します。View
data as ボックスで Voltage または
Normalized を選択します。

7. 水平軸の単位を選択します。Scale
ボックスで Points または Time を選
択します。
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8. Table をクリックすると Waveform ウィ
ンドウをテーブル表示にセットしま
す。

9. Table を選択したときは、Analog か
Digital のいずれかを指定します。

10.Digital を選択すると、Binary か Hex
を選択できます。

11.水平軸と垂直軸の単位を選択しま
す。テーブル表示で Digital が選択
されている場合垂直軸の単位設定
(Voltage または Normalized) は無効
になります。

12.Waveform ウィンドウの各チャンネル
で表示されるアイテムを選択できま
す。

Sequence ウィンドウ

1. View > Display Properties... を選択
すると、ダイアログ・ボックスが表示
されます。

Sequence Window タブをクリックしま
す。

2. 表示フォーマット (Graphic または
Table) を選択できます。

3. Graphic を選択した場合、Thumbnail
または Waveform Name のいずれか
を選択します。
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ヒント

（AWG7000 シリーズのみ） あるチャンネルの DAC 分解能が 10 ビットに設定されると、そのチャンネル
のマーカ・データは表示されません。

Waveform または Sequence ウィンドウで右クリックしても Display Properties ダイアログ・ボックスにアクセ
スできます。

Run State コントロールと出力のオン / オフ
任意波形ゼネレータで信号発生の開始および停止をコントロールするには、以下のステップを実行します。

1. 前面パネル Run ボタンを使用して
信号発生の開始および停止をコン
トロールします。

信号発生のオン / オフ切り替えを
Run State （動作状態） コントロール
と呼びます。

信号が発生している状態で LED イ
ンジケータが点灯します。

2. 出力コネクタから実際に信号を出力
するには、前面パネルの All Out-
puts On/Off ボタンまたは Channel
Output On ボタンを押して、信号出
力をオンにする必要があります。

3. あるいは、Settings ウィンドウの Ch
n (Channel) ページを使用して信号
出力をオンにすることもできます。
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出力信号を設定する

アナログおよびマーカ出力

アナログおよびマーカ出力のパラメータ設定は前面パネルのボタン、または Settings ウィンドウの Channel
ページで行います。

1. 前面パネルの Level ボタンを使用
して、各チャンネルの振幅およびオ
フセット、マーカ出力のハイ / ロー・
レベル等を設定できます。

2. 同様に、Settings ウィンドウの Ch n
ページを使用して、振幅、オフセッ
ト、フィルタを設定できます。

3. マーカのハイ、ロー、ディレイを設
定できます。

4. (AWG7000 シリーズ) DAC 分解能
で 10 ビットを選択すると、マーカ出
力は無効になります。

5. Direct Output のオン/オフを選択し
ます。

6. (AWG5000 シリーズ) 各チャンネル
のアナログ出力に外部信号を付加
できます。

7. シーケンス・モード以外のとき、
Output Waveform で出力波形を選
択できます。アイコンをクリックする
と、Waveform List ダイアログ・ボック
スが表示されます。

8. シーケンス・モード以外のとき、
Waveform Rotation で、アナログ出
力信号の位相 (Phase) または遅延
(Delay) を設定できます。
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ヒント

各チャンネルはそれぞれ独立して出力のオン / オフを設定できます。あるチャンネルの出力がオンに設
定されると、アナログ出力とマーカ出力の両方がオンになります。

Direct Output をオンにすると、フィルタとオフセットの設定は無効になります。また振幅の設定範囲が変
わります。

(AWG7000 シリーズ) オプション 02 （拡張アナログ出力帯域） およびオプション 06 （ インターリーブ） の
製品ではフィルタとオフセットの設定はありません。また Direct Output の設定もありません。

(AWG5000 シリーズ)Add Input は、Direct Output がオフのときに使用できます。Direct Output が選択さ
れていると、Add Input は無効になります。

Waveform Rotation は、各チャンネル独立して設定できます。

Analog Phase – 度 （°、degree） で指定します。

Analog Delay – 時間またはポイントで指定します。

Waveform Rotation の設定を行っても Waveform ウィンドウの波形表示には影響しません。

DC 出力ページ

1. 任意波形ゼネレータは 4 つの DC
出力を持ちます。

DC 出力のレベルは個別に設定で
きます。

2. 出力状態（オン / オフ） の切り替え
はすべての DC 出力チャンネルに
共通です。
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Timing コントロール

サンプリング・レートやクロックのパラメータは、Settings ウィンドウの Timing ページで設定します。

1. Sampling Rate を設定します。

2. シーケンス・モード以外のとき Rep-
etition Rate を設定できます。

3. クロック・ソース (Internal または
External) を選択します。

External のときは、外部オシレー
タからのクロック信号が使用され
ます。

Internal のときは、クロック信号は
内部で生成されます。

4. クロック・ソースが External のとき、
Divider Rate を設定できます。

5. リファレンス・ソース (Internal または
External) を選択します。

リファレンス・ソースはクロッ ク・ソー
スが Internal のときのみ有効です。

6. 外部リファレンス・タイプ (Variable ま
たは Fixed) を選択します。

このパラメータは、クロック・ ソース
が Internal でリファレン ス・ソースが
External のときのみ有効です。

ヒント

サンプリング・レートは、クロック・ソースが Internal で、かつ次のいずれかの条件を満たすときに設定で
きます。

リファレンス・ソースが Internal のとき

リファレンス・ソースが External で、外部リファレンス・タイプが Fixed のとき

任意波形ゼネレータは、Fixed 外部リファレンス・ソースとして、10 MHz、20 MHz、または 100 MHz の信
号を受け入れます。

クロック・ソースが Internal、リファレンス・ソースが External、外部リファレンス・タイプが Variable のとき、
Multiplier Rate を設定できます。
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チャンネル結合

複数のチャンネルのパラメータ設定を一度に変更できます。この機能をチャンネル結合 (Channel Coupling) と
呼びます。

1. Settings > Coupling... を選択して、
Coupling ダイアログ・ボックスを開き
ます。

または、Settings ウィンドウの Chan-
nel ページで右クリックしてもこのダ
イアログ・ボックスを開くことができま
す。

2. Coupling の方法を選択します。

Ch 1 –> Ch 2 and Ch 3 –> Ch 4 を
選択すると、Ch 1 と Ch 2、Ch 3 と
Ch 4 のパラメータがそれぞれ結合
されます。

3. Ch 1 -> Ch 2, Ch 3, Ch 4 を選択す
ると、Ch 1 のパラメータと Ch 2、 Ch
3、Ch 4 のパラメータが結合されま
す。

ヒント

Ch 1-> Ch 2, Ch 3, Ch 4 は、Ch 1 と Ch 2、Ch 3、Ch 4 が結合されることを意味します。すなわち、
Coupling がオンの状態で、Ch 1 のパラメータの値が本機器のハードウェア設定に適用されます。Settings
ウィンドウの Ch 2、Ch 3、Ch 4 ページで Coupling の対象となるパラメータは灰色表示になり、選択でき
なくなります。

下記のパラメータは、チャンネル結合の対象から除外されます。

チャンネル・スキュー

出力波形

シーケンス波形

外部信号付加機能

Waveform Rotation 機能

マーカ・ディレイ

出力信号に関係のないパラメータ、たとえばマーカ表示のオン / オフなど
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チャンネル・スキュー調整

チャンネル・スキューとは、各チャンネルのスキュー （遅延） を調整する機能です。

System > Channel Skew... を選択する
と、ダイアログ・ボックスが表示されま
す。

1. 各チャンネルのスキューをそれぞ
れ独立して調整できます。この設定
は、アナログ出力およびマーカ出力
の両方に適用されます。

2. スキューの値を調整すると、ダイア
ログ・ボックスの表示が更新されま
す。

注： ご使用の機器が 1 チャンネル・モデルの場合、チャンネル・スキューの機能は使用できません。

インターリーブ
AWG7000C シリーズのオプション 06 型および AWG7122B 型のオプション 06 型には、インターリーブ機能
が付いています。2 つのチャンネルをインターリーブして、より高いサンプリング・レートと長い波形長を実現
します。

1. インターリーブをオンにするには、
Settings ウィンドウの Ch 1 ページを
選択し、Interleave ボックスをチェッ
クします。

2. インターリーブをオンにすると、Ch2
ページが灰色になり、Ch2 のパラ
メータは選択できなくなります。
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3. インターリーブがオンの状態のとき、
Zeroing のオン / オフを選択できま
す。

Zeroing をオンにすると、帯域は増
大しますが、振幅の設定レンジが変
わります。デフォルトでは、Zeroing
オフです。

ヒント

インターリーブはアナログ出力に適用されます。インターリーブがオンのときには、0, 0, 2, 2, 4, 4, 6, 6 と
いうように偶数番号のマーカ・データが出力されます。

出力がオンの状態でインターリーブのオン / オフを切り替えると、出力はオフになります。

以下の表に、インターリーブによって拡大されるサンプル・レートと波形長の関係がまとめられています。

機種名およびオプショ
ン インターリーブ サンプリング・レート 波形長

オン 12 GS/s ～ 24 GS/s 2 ～ 129,600,000 ポイン
ト

AWG7122C 型 、
AWG7122B 型

（オプション 01 型、オプ
ション 06 型）

オフ 10 MS/s ～ 12 GS/s 1 ～ 64,800,000 ポイン
ト

オン 8 GS/s ～ 12 GS/s 2 ～ 129,600,000 ポイン
ト

AWG7082C 型

（オプション 01 型、オプ
ション 06 型） オフ 10 MS/s ～ 8 GS/s 1 ～ 64,800,000 ポイン

ト

オン 12 GS/s ～ 24 GS/s 2 ～ 64,800,000 ポイン
ト

AWG7122C 型 、
AWG7122B 型

（オプション 06 型） オフ 10 MS/s ～ 12 GS/s 1 ～ 32,400,000 ポイン
ト

オン 8 GS/s ～ 16 GS/s 2 ～ 64,800,000 ポイン
ト

AWG7082C 型

（オプション 06 型）

オフ 10 MS/s ～ 8 GS/s 1 ～ 32,400,000 ポイン
ト

AWG7122C 型 、
AWG7122B 型

（オプション 01 型）

なし 10 MS/s ～ 12 GS/s 1 ～ 64,800,000 ポイン
ト

AWG7082C 型

（オプション 01 型）

なし 10 MS/s ～ 8 GS/s 1 ～ 64,800,000 ポイン
ト
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機種名およびオプショ
ン インターリーブ サンプリング・レート 波形長

AWG7122C 型 、
AWG7122B 型

（標準モデル）

なし 10 MS/s ～ 12 GS/s 1 ～ 32,400,000 ポイン
ト

AWG7082C 型

（標準モデル）

なし 10 MS/s ～ 8 GS/s 1 ～ 32,400,000 ポイン
ト

インターリーブ調整

インターリーブは、チャンネル 1 とチャンネル 2 の出力を合成して 1 チャンネルの 2 倍のサンプリング・レートを
実現する機能です。インターリーブがオンのとき、チャンネル間の位相と振幅の相対的な値を調整できます。

1. Ch 1 の Amplitude が 0.75Vp-p に
設定されているとします。Ch 1 の
Amplitude は Settings ウィンドウで
入力します。

2. System > Interleave Adjustment...
を選択して、Interleave Adjustment
ダイアログ・ボックスを表示します。

Relative Amplitude の調整値として、
たとえば 0.100 Vp-p を入力します。

3. 内部的に Ch 1 Amplitude と Ch 2
Amplitude の値が調整されます。計
算式は下記のヒント参照。

4. Relative Phase は、Ch 1 を固定し、
Ch 2 を変化させることにより調整さ
れます。調整値の単位は度 (°) で
す。設定レンジは次のとおりです。

–180.0 ～ +180.0°
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ヒント

Amplitude では、内部的に Ch 1 と Ch 2 の両方が調整されます。内部 Amplitude の値は次の式で計算
されます。

Internal Ch 1 Amplitude = Ch 1 Amplitude Value – Adjustment Value

Internal Ch 2 Amplitude = Ch 1 Amplitude Value + Adjustment Value

注： Amplitude 調整では、Ch 1 の Amplitude の設定可能範囲で調整値を設定できます。Ch 1 Amplitude の
設定によっては、調整値が 大値または 小値にクリップされ、その値がハードウェアに適用されます。

デジタル出力（オプション 03 型）
AWG5002C 型、AWG5012C 型、AWG5002B 型、AWG5012B 型の各機器では、オプション 03 型によりデジ
タル・データ出力が可能になります。

1. 後部パネルに Ch 1 用、Ch 2 用に
そ れぞれ 14 ビットのデジタル・デー
タ出力用の SMB コネクタが用意さ
れています。
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2. 出力レベル・パラメータとして次の
いずれかを指定します。

Digital Amplitude/Offset

Digital High/Low

デジタル出力のレベルは次のとお
りです。

–1.0 V ～ +2.7 V、50 Ω 終端

分解能 0.01 V

ヒント

Ch 1 と Ch 2 の出力は個別にコントロールできますが、アナログ出力とデジタル出力は、同時にオン / オ
フされます。
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設定の保存と呼出し

機器設定の保存や呼び出し、波形データのインポート、エクスポートなどの基本的なファイル操作は File メ
ニューを使用します。また、 近使用した設定の呼び出しなどの Windows の標準的な操作も File メニュー
で行います。

File メニュー
下記のメニュー・コマンドが File メニューに用意されています。各メニュー・コマンドの詳細については、オ
ンライン・ヘルプを参照してください。

1. 工場出荷時設定を呼び出します。
(47ページ 「デフォルト設定」参照)。

2. 機器設定をロードするためのダイア
ログ・ボックスを表示します。

3. 機器の設定を保存 （上書き） しま
す。

4. 機器の設定に名前をつけて保存し
ます。

5. 波形データをインポートします。

6. 波形データを他のアプリケーション
で使用するためにエクスポートでき
ます。

7. 近アクセスした設定ファイルがこ
こに表示されます。

8. アプリケーションを終了します。

9. アプリケーションを終了し、機器を
シャットダウンします。
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ヒント

アプリケーションを起動した状態で、前面パネルのパワー・ボタン （On/Standby スイッチ） を押すことに
より、機器をシャットダウンすることもできます。パワー・ボタンを押すと、現在の設定を保存するかどうか
を確認するダイアログ・ボックスが表示され、機器のシャットダウン・プロセスが開始されます。

機器設定を保存する
機器の設定を保存するには、下記の手順を実行します。

1. File > Save File を選択すると、既存
の機器設定を更新された設定ファ
イルで上書きします。

2. 現在の設定を新しい設定ファイルと
して保存するには、File > Save File
As... を選択するか、または前面パ
ネルの Save ボ タンを押します。

3. 設定を保存する場所を選択します。

4. ファイル名を入力するか、デフォル
トの名前を使用します。

5. Save をクリックします。

ヒント

設定を保存するときに、波形フォーマットが Integer の場合は、設定ファイルのサイズが小さくなります。
波形のデータ・フォーマット (Real または Integer) についての詳細は、オンライン・ヘルプを参照してくだ
さい。

Waveform、Waveform List、Settings の各ウィンドウで、波形のフォーマットを変換するときは、Waveform
Properties ダイアログ・ボックスを使用します。(63 ページ 「波形のプロパティを確認する」 参照)。
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機器設定を呼び出す
File メニューまたは Windows Explorer から機器設定を呼び出すことができます。

1. File > Open File... を選択すると、
Open File ダイアログ・ボックスが表
示されます。

2. 設定ファイルを選択します。

3. Open をクリックします。

ヒント

任意波形ゼネレータでは、拡張子が .AWG のファイルを設定ファイルとして使用します。Open File ダイ
アログ・ボックスでは、デフォルトで AWG のファイルのみが表示されます。

いったん設定を呼び出すと、呼び出された設定は Save File または Save File As... が実行されるまで保持
されます。機器のパラメータを変更後、Save File を選択すると、設定ファイルはただちに上書きされます。

設定ファイルが呼び出されると、DC Output を含む出力ステータスはオフになります。

注： AWG5000 シリーズおよび AWG7000 シリーズで作成した設定ファイルには互換性がありますが、設定
ファイル中の数値パラメータが当該機器のサポート範囲を超えている場合は警告メッセージが表示されま
す。この場合、範囲外のパラメータはデフォルト値となります。

46 AWG5000 および AWG7000 シリーズ・クイック・スタート・ユーザ・マニュアル



設定の保存と呼出し

デフォルト設定
前面パネルの Factory Default ボタンを押すと工場出荷時設定を呼び出すことができます。

1. 機器の設定を工場出荷時状態に
戻すには、前面パネルの Factory
Default ボタンを押します。

2. 設定が変更されている場合、現在
の設定を保存するかどうかを確認す
るダイアログ・ボックスが表示されま
す。

3. File メニューからも工場出荷時設定
を呼び出すことができます。
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電源投入時の設定を変更する
電源投入時に呼び出される機器設定を選択できます。

System > Preferences... を選択して、
Preferences ダイアログ・ボックスを表示
します。以下の中から電源投入時の設
定を選択できます。

1. Factory Default – 電源投入時に、工
場出荷時設定が呼び出されます。

2. Last Used File – 電源投入時に、
後に保存または呼び出された設定
が呼び出されます。

3. User Default File – 電源投入時に、
ユーザが指定した設定ファイルが
常に呼び出されます。

4. フォルダ・アイコンをクリックすると設
定ファイルを指定するためのダイア
ログ・ボックスが表示されます。

このアイコンは、User Default File が
選択されたときに有効になります。

48 AWG5000 および AWG7000 シリーズ・クイック・スタート・ユーザ・マニュアル



設定の保存と呼出し

波形データのインポート
データ・インポート機能によって本機器以外で作成された波形データを使用することができます。データをイ
ンポートして新しい波形を作成したり、既存の波形データを置き換えることができます。

任意波形ゼネレータは、次のファイル形式をサポートします。

AWG5000 シリーズおよび AWG7000 シリーズで作成した *.AWG ファイル

Tektronix AWG400、AWG500、AWG600、AWG700 シリーズ等で作成した次のファイル形式

*.PAT

*.SEQ

*.WFM

Tektronix AFG3000 シリーズの任意／ファンクション・ゼネレータで作成した *.TFW ファイル

Tektronix DTG5000 シリーズのデータ・タイミング・ゼネレータで作成した *.DTG ファイル

Tektronix TDS/DPO シリーズのオシロスコープで作成した波形ファイル（*.WFM、*.ISF）

テキスト・ファイル (*.TXT)

ファイル・インポートの詳細は、オンライン・ヘルプを参照してください。

1. File > Import from File... を選択す
ると、Import from File ダイアロ グ・
ボックスが表示されます。
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2. インポートする波形データのフォー
マットを選択します。

3. OK をクリックします。ステップ 4 に
示すような、File Import ダイアログ・
ボックスが表示されます。
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4. インポートするファイルを選択しま
す。

5. Operation でインポート動作を指定
します。

Set to – チャンネルとインデック
ス番号を指定します。指定した
位置にインポートする波形が割
り当てられます。

Insert before – インポートする波
形が指定し たセルの前に挿入
されます。動作モードがシーケ
ンス以外の場合、このパラメータ
は無効になります。

Create only – インポートする波
形が Waveform List ウィンドウに
表示されます。

Overwrite – 既存の波形データ
が上書きされます。

6. Change H/W Setup を使用して、イ
ンポートする波形データにサンプリ
ング・レートや振幅、オフセットの情
報が含まれる場合、その情報を取り
込むかどうかを指定できます。

たとえば、Sampling Rate をチェック
すると、インポートするデータと同じ
波形が再現されるように、サンプリン
グ・レートが適切に設定されます。

7. Open をクリックします。

インポートする波形のフォーマッ ト
が、*.AWG、*.DTG、*.TXT の場合
は、それぞれに対応するダイアログ・
ボックスが表示されます。

インポートする波形のフォーマット
が、*.AWG、*.DTG、*.TXT 以外の
場合は、選択したファイルがインポー
トされ、波形名が Waveform List ウィ
ンドウにリストされます。
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8. インポートするファイルが Tek-
tronix AWG5000 シリーズまたは
AWG7000 シリーズの場合、右のよ
うなダイアログ・ボックスが表示され
ます。

インポートする波形を選択します。

9. OK をクリックすると、波形データが
インポートされます。

一度に複数の波形データをイン
ポートすることができます。

10.インポートするファイルが Tektronix
DTG5000 シリーズの場合、右のよう
なダイアログ・ボックスが表示されま
す。

11.インポートする DTG5000 シリーズブ
ロック・データの各ビット (DTG bits)
を本機器のビット (AWG bits) に割
り当てます。
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12. インポートするファイルがテキスト・
ファイルの場合、右のようなダイアロ
グ・ボックスが表示されます。Format
で、ファイル形式を選択します。

DAC の各ビットを指定したいときに
Digital を選択します。AWG5000 シ
リーズでは、Digital は 14 ビットに固
定されています。

13.Normalize で、ノーマライズの方法
を選択します。

None – ノーマライズを行いませ
ん。

Fit to DAC range, preserve off-
set – 0 を基準としてスケーリン
グされます。

Fit to full DAC range – 元のデー
タの 小値が –1.0、 大値が
+1.0 になるようにスケーリングさ
れます。

14.インポート実行時に、同じ名称の波
形がすでに存在している場合、右の
ようなダイアログ・ボックスが表示さ
れます。波形を置き換える場合は、
Yes または Yes to All を選択しま
す。

ヒント

新しい波形を作成するときは、インポートしたファイルの名前が新規作成の波形名称となります。

ファイル・インポート機能を実行すると、既存の波形のサイズはインポートされたファイルと同じ波形長に
変更されます。
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波形データのエクスポート
任意波形ゼネレータは、波形データを *.TXT 形式のファイルに変換してエクスポートできます。また、
AWG400/500/600/700 シリーズで使用できるパターン・ファイルや波形ファイルを選択することもできます。

1. エクスポートする波形を選択します。
Waveform List ウィンドウで波形を選
択します。

2. 右クリックしてポップアップ・メニュー
を表示します。Export Waveform to
File... を選択してダイアログ・ボック
スを表示します。

Sequence または Waveform ウィンド
ウで右クリックしても、Export Wave-
form to File... を選択できます。

3. AWG7000 シリーズで Real 形式の
波形をエクスポートするときのダイア
ログ・ボックスの例です。

4. ファイル形式を選択します。

5. Real 形 式 の 波 形 を
AWG400/500/600/700 シリーズで
使用できる *.WFM ファイルにエク
スポートできます。
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6. AWG7000 シリーズで Integer 形式
の波形をエクスポートするときのダ
イアログ・ボックスの例です。

7. *.TXT形式を選択した場合、Analog
か Digital を選択します。DAC の各
ビットを指定したいときに Digital を
選択します。

8. Integer 形 式 の 波 形 を
AWG400/500/600/700 シリーズで
使用できる *.PAT ファイルにエクス
ポートできます。

9. OK をクリックします。ステップ 10 に
示すようなダイアログ・ボックスが表
示されます。

10.波形データ・ファイルを保存する場
所を選択します。

11.Waveform List ウィンドウで選択した
波形の名前が表示されます。

12.Save をクリックします。選択した波
形データを指定した形式のファイル
としてエクスポートできます。

ヒント

アナログ・データはノーマライズした値としてエクスポートされます。

Integer 形式の波形データをエクスポートするときは DAC 分解能を選択できます。選択した DAC 分解
能が Integer データをノーマライズ・データの変換に使用されます。

波形フォーマット （Real または Integer） を変更するには、Waveform Properties ダイアログ・ボックスを使
用します。(63 ページ 「波形のプロパティを確認する」 参照)。
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波形の表示と編集

Waveform ウィンドウ
Waveform ウィンドウを使用して新規に作成された波形や Waveform List ウィンドウにリストされているユーザ
定義波形の編集を行います。Sequence ウィンドウで選択されたエレメントまたは Settings ウィンドウの Ch n
ページで選択された波形が Waveform ウィンドウに表示されます。

1. Waveform ウィンドウのグラフ表示の
例です。Ch1 と Ch2 のアナログ・
データとマーカ・データが表示され
ています。

2. このアイコンをクリックするとグラフ
表示とテーブル表示が切り替わりま
す。

3. このアイコン (Vertical Best Fit) をク
リックすると、すべてのエレメントが
Waveform ウィンドウ内におさまるよ
うにアナログ・チャンネルの高さを調
整して表示します。

4. テーブル表示の例です。

テーブル表示では、アナログかデ
ジタルを選択できます。この例はバ
イナリ形式のデジタル表示です。

ヒント

アナログ・データのみ、マーカ・データのみ、またはアナログとマーカの両方を選択して Waveform ウィン
ドウに表示できます。

Waveform ウィンドウの波形データをクリア （初期化） するには、Edit > Clear を使用します。

垂直軸と水平軸の単位は、Display Properties ダイアログ・ボックスを使用して設定します。(32 ページ
「ウィンドウの表示スタイルを変更する」 参照)。

Waveform List ウィンドウの波形を Waveform ウィンドウにセットするには、波形を選択して任意のチャン
ネルにドラッグ・アンド・ドロップします。
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ズームを使用する
一時的に波形の詳細を見たい場合、ズーム機能を使用します。波形表示を拡大するには、View メニューの
ズームコマンドを選択します。詳細は以下の通りです。

1. Zoom In – Zoom In は水平方向と
垂直方向に同時に波形を拡大しま
す。

2. Horizontal Zoom In – Horizontal
Zoom In は水平方向に波形を拡大
します。

3. Vertical Zoom In – Vertical Zoom In
は垂直方向に波形を拡大します。

ズーム時の垂直軸のスケール定
義については、Preferences ダイ
アログ・ボックスで設定できます。
(31 ページ 「スクリーン表示のユー
ザ設定」 参照)。

4. Zoom Out – Zoom Out は前のズー
ム倍率に戻します。Zoom Out は波
形を拡大した後でのみ使用できま
す。

5. Fit to Window – Fit to Window は、
波形をウィンドウ・サイズに合わせ、

初のズーム・イン操作の前の状態
に戻します。Fit to Window は波形
を拡大した後でのみ使用できます。

6. ズーム表示を簡単に設定するには
Waveform ウィンドウ上の Zoom アイ
コンを使用します。

Zoom アイコンのいずれかを選択し
て、波形上でクリックし、ド ラッグし
てズームの対象となる部分のボック
スを作成します。あるいは、波形の
ポイントで単にクリックします。
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波形の作成と編集
Edit メニューを使用して、新しい波形を作成したり、既存の波形を編集できます。

Undo は直前の操作をキャンセル
し、Redo は直前の操作を繰り返し
ます。

Undo は、カーソル位置、ズーム、お
よびスクロール機能では適用されま
せん。

Create Analog Waveform または
Create Digital Pattern では、ダイア
ログ・ボックスが開いて波形やデジ
タル・パターンを作成できます。

Equation Editor では、数式エディタ
が開いて複雑な波形を生成するた
めの数式を作成できます。

基本的な編集機能である波形の切
り取り、コピー、貼り付け、削除が使
用できます。

シーケンスまたはサブシーケンス
では、Cut、Copy、Delete はアクショ
ン・ボタンとなります。

Delete All Waveforms は、設定ファ
イル内のすべてのユーザ定義波形
を削除します。

Clear は、Sequence ウィンドウで選
択されたエレメントの内容を削除し
ます。残りのエレメントは移動しませ
ん。

Waveform ウィンドウでは、選択した
チャンネルの波形データを Clear し
ます。
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標準波形の作成
Create Analog Waveform ダイアログ・ボックスを使用して新しい波形を作成できます。

1. Edit > Create Analog Waveform を
選択して、Create Analog Waveform
ダイアログ・ボックスを開きます。

2. Function で波形のタイプを選択しま
す。サイン波、三角波、方形波、ラ
ンプ波、ガウシャン・ノイズ、または
DC から波形を選択できます。

3. Timing では、周波数、波形長、お
よびサイクルの各パラメータを設定
できます。

4. Sampling Rate で Auto、No Change
のいずれかを指定します。

Auto - 信号周波数に応じて適
切な波形長とサンプリング・レー
トが自動的に設定されます。

No Change - サンプリング・レー
トは変化しません。周波数、波
形長、サイクルのうちの 2 つの
パラメータを設定すると、残りの
1 つは自動的に計算されます。

5. Preview に波形が表示されます。
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6. Level で、振幅 / オフセットまたは
ハイ / ローのパラメータを設定でき
ます。

7. Option で、振幅 / オフセットの設定
方法を選択します。Option フレーム
は、垂直軸の単位に Voltage を選
択したときのみ表示されます。

垂直軸の単位に Normalized Value
を選択すると Option フレームは無
効になります。(32 ページ 「ウィン
ドウの表示スタイルを変更する」 参
照)。

8. Operation で、波形の作成方法や
位置を指定します。

Set to – チャンネルとインデック
ス番号を指定して、新規に波形
を作成します。指定した位置に
作成した波形がアサインされま
す。

Insert before – 作成する波形が
Sequence ウィンドウの指定した
セルの前に挿入されます。動作
モードがシーケンス以外の場合、
このパラメータは無効になりま
す。

Create Only – 新規に波形を作
成しますが、波形はロードされ
ません。Waveform Name 欄に波
形の名称を入力します。作成さ
れる波形は Waveform List ウィ
ンドウのユーザ定義波形リストに
表示されます。

Overwrite – 既存の波形データ
が上書きされます。このコマン
ドを選択すると、現在ロードされ
ている波形が Target Waveform
Name ボックスに表示されます。
波形名称を入力するボッ クス
(Waveform Name) は無効になり
ます。

9. Execute をクリックすると、波形が作
成されます。
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ヒント

Create Digital Pattern を使用しても、アナログ波形の作成と同じ方法でデジタル・パターンを作成できま
す。

数式エディタ

数式エディタはテキスト・ストリングを使用する ASCII 形式のテキスト・エディタで、数式ファイルの読み込み、編集、
およびコンパイルにより波形を作成します。このエディタは制御機能と柔軟性に優れ、Create Analog Waveform
ツールや Create Digital Patern ツールだけでは不可能な、より複雑な波形を作成することができます。エディタ
には Edit メニューからアクセスします。

以下は数式エディタの使用における制
約事項とガイドラインです。

1 つのテキスト・ストリングの 大文
字数は、スペースを含めて 256 文
字です。

1 つのプログラムの 大長（全ストリ
ング長の合計）は 1,000 文字です。

7 ビットの ASCII 文字セットのみ使
用できます。

ストリングの連結にはコロンを使用し
ます。ストリングに数値を埋め込む
例："AA":i:"Value"。

開く、保存、切り取り、コピー、貼り
付けなどの操作は、ツール・バーの
アイコンをクリックして行います。

タブには、数式の作成や編集に便利なツールが用意されています。

Soft Keypad タブを使用すると、画面上のキーボードでデータや文字を直接入力できます。

Basic Keywords タブを使用すると、定義済みの変数や制御ステートメントを素早く入力できます。

Waveform Functions タブを使用すると、よく使用する波形関数を素早く入力できます。

Math Functions タブを使用すると、演算関数を波形数式の一部として素早く入力できます。

数式エディタや波形関数の詳細については、オンライン・ヘルプを参照してください。
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設定ファイル内の波形を参照する

作成された波形は、Waveform List ウィンドウにユーザ定義波形として登録されます。Waveform List ウィンドウに
は、セットアップ・ファイル（*.awg）に保存された波形がリストされています。

1. 定義済み波形を選択するには、
Predefined タブをクリックします。

2. 定義済み波形の名前の左側にはア
スタリスク・サイン (*) がつきます。

注： 定義済み波形を編集、削除、名称
変更することはできません。

3. ユーザ定義波形を選択するには、
Waveform List で User Defined タブ
をクリックします。

選択した波形を Waveform ウインド
ウにドラッグすることにより、ユーザ定
義波形を編集することができます。

4. 波形の名称、波形長、または日付
順に波形リストをソートできます。

5. Waveform List ウィンドウでは、波形
長は数字 3 桁で表示されます。

6. 正確な波形長を知りたいときは、
波形を選択して右クリックし、ポッ
プアップ・メニューから Waveform
Properties... を選択して表示され
るダイアログ・ボックスで確認できま
す。

ヒント

Waveform List ウィンドウで右クリックすると、ポップアップ・メニューが表示されます。波形の削除、コピー
やペーストなどのメニューにアクセスできます。

ユーザ定義波形を作成するときに、定義済み波形と同じ名前をつけることはできません。定義済み波形
とは別の名前をつけてください。
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ユーザ定義波形の名称を変更する

Waveform List ウィンドウに表示されるユーザ定義波形の名前を変更できます。

1. Waveform List ウィンドウで波形を
選択し、メニュー・バーでEdit >
Rename... を選択すると Rename ダ
イアログ・ボックスを表示します。

2. 現在の波形名称が表示されます。

3. 新しい波形名を入力します。

波形のプロパティを確認する

Waveform Properties ダイアログ・ボックスを使用して、波形データのプロパティを参照したり、変更することができ
ます。

1. Waveform List ウィンドウの波形リス
トから波形を選択し、ポップアップ・
メニューからWaveform Properties...
を選択するとダイアログ・ボックスが
表示されます。

Waveform ウィンドウや Settings ウィ
ンドウの Ch ページで右クリックして
も Waveform Properties ダイアログ・
ボックスにアクセスできます。

2. 波形長を確認 / 変更できます。

3. 波形データのフォーマット（Real ま
たは Integer） を確認 / 変更できま
す。
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波形の編集
Standard Waveform ダイアログ・ボックスを使用して作成した波形、インポートした波形、Waveform List ウィン
ドウにリストされているユーザ定義波形を編集できます。

アイテムとレンジ

波形を編集するときは、編集のターゲットとして通常アイテムとレンジを指定します。

1. 波形を編集するために、これらのメ
ニューが用意されています。

2. 編集のアイテムとして次のいずれか
を選択します。

Ch n アナログ・データ

Ch n マーカ 1 データ / マーカ
2 データ

All – すべてのアイテムが編集
の対象となります。All は Cut や
Copy で使用されます。

All Analog – すべてのアナログ・
データが編集の対象となります。
Scale や Offset のメニューで選
択できます。

All Markers – すべてのマーカ・
データが編集の対象となります。

3. 編集のレンジとして次のいずれかを
選択します。

All – 選択したアイテムの全レン
ジが編集の対象となります。

Between Cursors – 2 つのカーソ
ル間が編集の対象となります。

Selected – 選択した範囲が編集
の対象となります。テーブル表
示のときのみ有効です。

注： 内部クリップボードは、本機器のアプリケーション内にあり、Windows のクリップボードとは別のもので
す。Microsoft Excel 等から本機器のクリップボードにデータを転送することはできません。他のアプリケーショ
ンからのデータ転送では、インポート / エクスポート機能を使用します。
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Cut および Paste 操作例

以下の手順では、Waveform ウィンドウ （グラフ表示） での Cut と Paste の操作例を示します。テーブル表示で
も Cut や Paste を実行できます。

1. 編集したいアイテムを選択します。
この例では 2 つのチャンネルを使
用して波形のカットやペーストを行
います。

2. カーソルを使用してレンジを指定し
ます。

3. Edit > Cut... を選択して Cut ダイ
アログ・ボックスを開きます。次のよ
うに選択します。

Items – Selected

Range – Between Cursors

アイテムやレンジを変更したいとき
は、このダイアログ・ボックスで変更
できます。

4. OK をクリックします。

5. 波形の選択した部分がカットされま
す。

注： 一部のアイテムがカットまたは削除
されても波形長は短くなりません。デー
タはシフトします。シフトした領域の後
の部分は、デフォルト値が入ります。

注： すべてのアイテムがカットまたは
削除されると、波形長はその分短くなり
ます。
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6. Ch 2 を選択します。

7. カーソルを使用して編集対象を指
定します。Edit メニューから Copy を
選択します。

8. Paste-Replace の例です。Ch 2 の
指定した範囲がペーストされ、Ch 1
の波形に置き換えられます。Ch 1
の波形長は変化しません。

9. Paste-Insert の例です。Ch 2 の指
定した範囲が Ch 1 の波形に挿入
されます。Ch 1 の波形長が変わり
ます。
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演算波形
Math ダイアログ・ボックスを使用して、編集している波形に対して演算を実行できます。2 つのアナログ波形
データを加算、減算、乗算できます。作成した波形は Waveform List に追加されます。

1. Tools > Math... を選択すると、Math
ダイアログ・ボックスが表 示されま
す。

2. New Waveform フィールドに波形の
名称を入力します。

3. 波形リストから波形を選択します。
アイコンをクリックすると、Waveform
List ダイアログ・ボッ クスが表示さ
れます。

4. 演算子を選択します。

5. (AWG7000 シリーズ) 分解能を選択
します。

6. Show Preview をチェックすると、演
算結果が Preview に表示されます。

7. OK をクリックすると、新しい波形が
Waveform List ウィンドウに追加され
ます。

ヒント

演算結果により新規の波形が作成されます。マーカのデータは第 1 オペランドのものが引き継がれます。

波形演算はアナログ・データの波形全体に対して実行されます。

2 つの波形の長さが等しくない場合は、演算結果により生成される波形の長さは短い方の波形と同じに
なります。また、長い方の波形の初めの部分が計算に使われます。
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ノーマライズ・オプション

アナログ・データをノーマライズするときに、Tools メニューでノーマライズのオプション指定を行います。ノーマラ
イズは、波形のアナログ・データ全体に対して行われます。

Tools メニューからノーマライズのオプ
ションを指定します。

1. Fit to DAC range, preserve offset
0 を基準としてスケーリングされま
す。

2. Fit to full DAC range
元のデータの 小値が -1.0、 大
値が +1.0 になるようにスケーリング
されます。

その他の波形編集メニューを使用する

スケール: Edit メニューの Scale... を使用してアナログ・データの指定したレンジについて、波形の形状を維
持したまま大きさを変えることができます。

1. 垂直軸スケールの原点 (Origin) と
スケール・ファクタを設定できます。
スケール・ファクタに単位はありませ
ん。

2. アイテムやレンジを変更したいとき
は、このダイアログ・ボックスで変更
できます。(64 ページ 「アイテムとレ
ンジ」 参照)。
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Offset: Edit メニューの Offset... を使用して、アナログ・データの指定したレンジについて、定数を加えることが
できます。

1. オフセットは、Voltage または Nor-
malized Value で設定できます。

2. アイテムやレンジを変更したいとき
は、このダイアログ・ボックスで変更
できます。(64 ページ 「アイテムとレ
ンジ」 参照)。

Invert: Edit メニューの Invert... を使用して、指定したレンジのデータを反転させることができます。

1. アナログ・データでは、プラスの値
がマイナスになります。マーカ・デー
タでは、ロー (0) がハイ (1) になりま
す。

アイテムやレンジを変更したいとき
は、このダイアログ・ボックスで変更
できます。(64 ページ 「アイテムとレ
ンジ」 参照)。
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Horizontal Shift/Rotate: Edit メニューの Shift/Rotate... を使用して、指定したレンジの波形データを水平方
向に Shift または Rotate （回り込みシフト） することができます。

1. モード （Shift または Rotate） を選
択します。

時間またはポイントで、シフト量や
回転量を指定できます。

2. Linear または Quadratic の補間方
法を選択します。

3. アイテムやレンジを変更したいとき
は、このダイアログ・ボックスで変更
できます。(64 ページ 「アイテムとレ
ンジ」 参照)。

ヒント

Horizontal Rotate は、波形が繰り返し出力される場合に、ある波形の 後の部分と次の波形の冒頭部分
が滑らかにつながっているかどうかを確認するために使用されます。

Horizontal Shift/Rotate はアナログ・データおよびマーカに適用されます。
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All High/All Low: Edit > Modify Pattern メニューの All High/All Low で、指定したレンジのマーカ・データをハ
イまたはローに設定することができます。

1. All High または All Low を選択しま
す。

2. 必要に応じて、Level パラメータを
変更します。

3. Item および Range を選択します。

PRBS: Edit > Modify Pattern メニューの PRBS で、指定したレンジのデータを PRBS パターンで置き換えるこ
とができます。

1. Equation リストから PRBS パターン
を選択します。

2. Mark Density を選択します。

3. 必要に応じて、Level パラメータを
変更します。

4. Item および Range を選択します。
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User Defined: Edit > Modify Pattern メニューの User Defined では、指定したレンジの波形データを選択したデ
ジタル・パターンで埋めることができます。

1. パターンに Binary または Hex を選
択します。

2. パターンを直接入力するか、内部
ハード・ドライブや外部メモリ・デバ
イスからテキスト・ファイル形式で読
み込むこともできます。

ビット・パターンの 大長は 1,000
です（16 進では 250 文字）。

3. 必要に応じて、Level パラメータを
変更します。

4. Item および Range を選択します。

ターゲットとして複数の項目が指定
されている場合は、すべての項目
に対して同一のデータが作成され
ます。

クロック: Edit > Modify Pattern メニューの Clock では、指定したレンジのデータをクロック・パターンで置き換
えることができます。

1. Start Level を選択します。

2. Low Step および High Step の値を
入力します。

3. 必要に応じて、Level パラメータを
変更します。

4. Item および Range を選択します。
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Binary Counter: Edit > Modify Pattern メニューの Binary Counter では、指定したレンジのデータをバイナリ・
カウンタ・パターンで埋めることができます。

1. パターンの方向 （Up counter また
は Down counter） を指定します。

Up counter は all 0 から始まり、Down
counter は all 1 から始まります。

2. 必要に応じて、Level パラメータを
変更します。

3. Item および Range を選択します。
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シーケンス

DUT の完全な動作テストを行うには、しばしば長い波形ファイルを作成する必要があります。波形の一部
が繰り返される場合、波形シーケンス機能によって、大量のメモリを消費するプログラミング作業を大幅に減
らすことができます。

シーケンスは主に下記の用途で使用されます。

ハードウェアの波形メモリよりも長い波形を出力したいとき

出力信号を高速で切り替えたいとき （ATE アプリケーションなど）

注： オプション 08 がついていない機器では Wait Trigger がオンにセットされます。Wait Trigger をオフに
するにはオプション 08 がインストールされている必要があります。

ヒント

オプション 09 型を使用した機器の場合は、シーケンスを単独で使用する代わりに、シーケンスとサブ
シーケンスを併用することで、より長い波形ファイルが作成できます。

Sequence ウィンドウ

動作モードで Sequence が指定されると、このウィンドウにはシーケンス設定の情報が表示されます。(25 ページ
「Run モード」 参照)。

Sequence ウ ィ ン ド ウのサムネイル
（Thumbnail）表示例です。

1. 任意のセルでクリックすると選択し
た波形が Waveform ウィンドウに表
示されます。選択したセルの背景色
が変わります。

2. マウスをセルに持っていくと、そのセ
ルに表示されている波形の名称と
波形長がツールチップ （小さいポッ
プアップ・ウィンドウ） で表示されま
す。

3. Switch to Table をクリックするとテー
ブル表示に変わります。

74 AWG5000 および AWG7000 シリーズ・クイック・スタート・ユーザ・マニュアル



シーケンス

テーブル表示の例です。テーブル表示
では、Repeat カウントや Go To のター
ゲットなどのシーケンス・パラメータを直
接入力できます。

ヒント

既存の波形をシーケンスに適用するために、次の方法が用意されています。

Waveform List ウィンドウの波形を Sequence ウィンドウのセルにドラッグ・アンド・ドロップする

Sequence ウィンドウでセルを指定してから、Edit メニューの Set Waveform... または Insert Waveform...
を使用する

動作モードで、Continuous、Triggered、または Gated が選択されると、Sequence ウィンドウはスクリーンか
ら隠れます。

Sequence ウィンドウでは、下記のアイコンが使用されます。

表示アイコン 説明

Wait Trigger

Repeat ( この例では Repeat count が 26 に設定されています)

Repeat (Infinite、無限に繰り返します)

Event Jump ( この例では Jump ターゲットがインデックス番号 26
に設定されています)

Go To ( この例では Go To のターゲットが 26 に設定されていま
す)

サブシーケンス

AWG5000 および AWG7000 シリーズ・クイック・スタート・ユーザ・マニュアル 75



シーケンス

シーケンスを作成する
シーケンスを作成するには、波形を Sequence ウィンドウにセットする必要があります。以下の例でシーケン
ス作成の基本的なステップを示します。

1. Waveform List ウィンドウで波形を選
択します。

2. 波形を Sequence ウィンドウのセル
にドラッグアンドドロップします。

クイック・アクセスとして、セル上で
ダブルクリックまたは右クリックして
も波形リストにアクセスできます。

3. 波形をシーケンスのセルにセットし
た後に、シーケンス・パラメータを定
義します。

セル上で右クリックするか、または
Edit から Sequence Control Param-
eters ダイアログ・ボックスを開きま
す。

4. Wait Trigger がチェックされると、
シーケンサはそのエレメントの波形
を出力する前にトリガを待ちます。

5. シーケンスの各エレメントで Repeat
カウントが指定されると、波形が指
定された回数繰り返されます。

6. Event Jump To は、外部イベントに
よって波形の出力順序を変更しま
す。

イベント信号については、後述する
ヒントを参照してください。

7. シーケンス・エレメントに Go To ター
ゲットを指定すると、指定された波
形の出力が終わり次第、シーケンサ
は Go To で指定されたエレメントへ
制御を移します。
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8. シーケンス・エレメントは、すべての
アナログ波形データとマーカ・デー
タで構成されており、インデックス番
号が付きます。

9. 選択したエレメントをカレント・エレ
メントと呼びます。

10.Sequence ウィンドウで選択したエレ
メントが Waveform ウィンドウに表示
されます。

ヒント

Standard Waveform ダイアログ・ボックスを使用して波形を作成し、その波形を直接 Sequence ウィンドウ
に適用することもできます。

波形インポート時に、波形を Sequence ウィンドウに直接セットすることも可能です。

動作モードで Sequence が指定されると、シーケンス定義に従って波形の出力が行われます。シーケンス
定義は連続するシーケンス・エレメントからなり、各々のシーケンス・エレメントは以下の情報を持ちます。

各チャンネルの波形への参照

シーケンス制御パラメータ （Wait Trigger、Repeat、Event Jump To および Go To）

シーケンスは 初のエレメント （Element Index = 1） から順に実行されます。ただし Event Jump To ある
いは Go To の指定がある場合にはそれに従って実行されます。

イベントとして、以下の信号がサポートされます。

前面パネルの Event Input コネクタに適用される信号

前面パネルの Force Event ボタンが押された場合

リモート・コマンド – EVENt[:IMMediate]

大シーケンス長は機種によって異なります。

機器の型名 大シーケンス長

AWG7000 シリーズ 1 ～ 16,000 ステップ

AWG5000 シリーズ 1 ～ 8,000 ステップ
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注： 任意波形ゼネレータには、作成したシーケンスを実行するモードとしてハードウェア・シーケンサとソフ
トウェア・シーケンサの 2 つのモードがあります。2 つのモードの違いについては、オンライン・ヘルプを参
照してください。

サブシーケンスの作成
サブシーケンスは、既存のシーケンスから呼び出せるシーケンスです。シーケンスは複数のサブシーケンス
を持つことができますが、サブシーケンスがサブシーケンスを持つことはできません。サブシーケンスはオプ
ション 09 型を搭載した機器で使用できます。サブシーケンスの使用に関する詳細は、オンライン・ヘルプ
を参照してください。

1. Subsequence ウィンドウのドロップダ
ウン・リストから New Subsequence を
選択します。

2. 必要なだけ新しいサブシーケンス
を波形に追加します。 (76 ページ
「シーケンスを作成する」 参照)。

3. セルを右クリックして、Sequence
Control Parameters を選択します。
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4. サブシーケンス・エレメントごとにリ
ピート・カウントを指定します。

注： サブシーケンス・エレメントに対し
ては、リピート・カウントを Infinite に設
定することはできません。

5. サブシーケンス内のすべてのエレメ
ントの定義が終了したら、サブシー
ケンスに名前を付ける必要がありま
す。マウスを右クリックして、Name
Subsequence を選択します。

6. 新しいサブシーケンスの名前を入
力します。

Waveform List ウィンドウのサブシー
ケンスのリストに、新しいサブシーケ
ンスが追加されます。
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シーケンスを編集する
作成したシーケンスを編集するために、次のコマンドが用意されています。

Set Waveform および Insert Waveform: これらのメニューを使用して、Sequence ウィンドウのセルに波形
をセットまたは挿入します。

Clear: Clear は選択されたデータを初期化します。複数の非連続なエレメントをクリアすることができます。
シーケンスの残りのデータはシフトしません。

Cut および Delete: Cut と Delete はエレメント単位で実行できます。複数の連続するエレメントを一度に
カットまたは削除できます。

Copy、Paste-Insert および Paste-Replace: 1 つまたは複数の連続したエレメントに対してコピーやペー
ストを行うことができます。クリップボードのデータがシーケンスの指定した位置に挿入または置き換えられ
ます。Paste-Insert では、残りのデータはシフトします。

操作例

以下の手順では、Sequence ウィンドウのテーブル表示を使用した Cut、Clear と Paste の例を示します。

1. シーケンスを作成します。

2. カットするエレメントを選択します。
ここでは、インデックス番号 3 がカッ
トの対象となります。

注： Cut および Delete はエレメント単
位でしか行えません。
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3. Cut が実行され、残りのデータはシ
フトします。

注： Delete ではクリップボードのデー
タは変わりませんが、Cut ではカットさ
れたデータがクリップボードに入れられ
ます

4. Clear は選択したセルまたはエレメ
ントのデータを初期化します。クリア
されたセルは Empty となります。

5. Insert Waveform... を使用すると、
Waveform List からの波形を挿入で
きます。

6. Sequence ウィンドウで任意の波形
をコピーしたあとで、波形をセット
したいときは、Paste-Insert または
Paste-Replace を使用します。
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Event Jump
Settings ウィンドウの Event ページで、イベント信号のパラメータを設定できます。Event ページは、動作モー
ドが Sequence のとき使用できます。

1. 外部イベント入力のしきい値を設定
します。

2. 外部イベント入力の極性 (Positive
または Negative) を選択します。

Positive を選択すると、パルスの
立上がりでジャンプします。

Negative を選択すると、パルスの
立下りでジャンプします。

3. ジャンプ・タイミング (Async または
Sync) を選択します。

Async を選択すると、ジャンプは
ただちに実行されます。

Sync を選択すると、ジャンプは
現在の波形を出力したあとで実
行されます。

4. イベント入力インピーダンス (1 kΩ
または 50 Ω) を設定します。

ヒント

イベント・ジャンプ (Event Jump) とは、シーケンスをイベント信号で切り替える機能です。

ジャンプ・タイミングは、Event Jump と Force Jump の両方に適用されます。
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Force Jump To
Force Jump とは、シーケンス出力中に任意のタイミングで特定の位置を指定してジャンプさせる機能です。

System > Force Jump To... を選択する
と、Force Jump To ダイアログ・ ボックス
が表示されます。

1. Target でジャンプ・ターゲットを指定
するか、Index No を選択し ます。

2. Index No を選択した場合は、Value:
にジャンプ先のインデックス番号を
入力します。

3. Jump Now をクリックすると、波形出
力がジャンプ・ターゲットで指定した
位置に切り替わります。

ヒント

任意波形ゼネレータは、Force Jump とは別に Event Jump の機能も持っています。Event Jump は、シー
ケンスを外部からのイベント信号で切り替える機能です。

Force Jump は、Event Jump に似ていますが、ジャンプ先が Force Jump To ダイアログ・ボックスを使用
してユーザによって指定されます。

Force Jump は、Event Jump の指定とは無関係です。Event Jump の指定に関係なく Force Jump を実行
できます。
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表示エリア外のシーケンス・エレメントにアクセスする
長いシーケンスを作成すると、Sequence ウィンドウ内に表示しきれなくなります。View メニューの Go To ダイア
ログ・ボックスを使用して、Sequence ウィンドウで Index 番号を指定して表示ポイントをすばやく変更できます。

1. シーケンスを作成後、メニュー・バー
から View > Go To...、またはポップ
アップ・メニューで Go To... を選択
します。

ステップ 2 に示すようなダイアログ・
ボックスが表示されます。

2. Go To のターゲット （移動先） とし
て、Index No を選択します。

3. 値を入力します。

4. Go To ダイアログ・ボックスで OK を
クリックすると、表示が指定された位
置に切り替わります。

ヒント

Waveform ウィンドウや Waveform List ウィンドウでも Go To ダイアログ・ボックスが使用できます。
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操作例

ここでは、機器を使用して一般的な任意波形ゼネレータの作業を実行する方法を示します。以下の例では、
2 チャンネル・モデルを使用します。

波形の作成と編集

1. 機器の設定をデフォルトにします。

2. Run Mode で Continuous を選択し
ます。

3. Standard Waveform ダイアログ・ボッ
クスを使用して、下記のような方形
波を作成します。

Waveform Length: 960 points

Cycles: 5

Amplitude: 1.0 Vp-p

Offset: 0.5 V

4. ステップ 3 で作成した波形を Ch 1
にセットします。

5. 波形に Ch1-Square という名称をつ
けます。
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6. Standard Waveform ダイアログ・ボッ
クスを使用して、下記のようなサイン
波を作成します。

Waveform Length: 1024 points

Cycles: 3

Amplitude: 1.0 Vp-p

Offset: –0.5 V

7. ステップ 6で作成した波形を Ch 2
にセットします。

8. 波形に Ch2-Sine という名称をつけ
ます。

9. アナログ波形の編集を行うために、
Display Properties ダイアログ・ボッ
クスを使用して Ch 1 と Ch 2 の
Marker・データを非表示にします。

10.Ch 1 の波形と同じ長さにするため
に、Ch 2 の波形の後部をカットしま
す。

カーソルを使用してレンジを設定し
ます。

カーソルを図のように置きます。

Ch 2 波形を選択します。

右クリックして、Delete、Selected、
Between Cursors を選択します。

OK をクリックします。
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11.カットを実行すると、Ch 1 と Ch 2 の
波形長が同じになり、信号の出力が
可能になります。

12.設定を保存します。

シーケンスの作成と編集

1. 機器の設定をデフォルトにします。

2. Run Mode で Sequence を選択しま
す。
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3. Waveform List ウィンドウの Prede-
fined ページから *Sine960 の波形
を選択して Ch 1 のシーケンスの 1
番目のセルにセットします。

4. 同様に、*Triangle960 を選択して
Ch 1 のシーケンスの 2 番目のセル
にセットします。

5. 新規に下記のようなサイン波を作成
して、Ch 1 のシーケンスの 3 番目
のセルにセットします。

Waveform Length: 960 points

Cycles: 5

Amplitude: 1.0 Vp-p

Offset: 0.0 V

波形名: Sine-1

6. シーケンスの 3番目のセルを選択し
て、ポップアップ・メニューから Copy
を選択します。

7. シーケンスの 2 番目のセルを選
択して、ポップアップ・メニューから
Paste-Insert を選択します。
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8. コピーされた波形がインデックス 2
にペーストされます。

9. Switch to Table アイコンをクリッ クし
て、テーブル表示に変更します。

10.次のようにシーケンス・パラメータを
設定します。

Index 1: Wait Trigger On
シーケンスの 1 番目を出力する
前にトリガを待ちます。

Index 2: Repeat count Infinite
Sine-1 波形を無限に繰り返し ま
す。

Index 2: Event Jump To Next
イベント信号を受信すると、シー
ケンスは次のエレメントにジャン
プします。

Index 3: Repeat count 1000
*Triangle960 の波形を 1000 回
繰り返します。

Index 4: Go To 1
シーケンスはインデックス 4 の波
形を出力後、インデックス 1 に
ジャンプします。

11.Run ボタンを押してシーケンスが
正常に動作することを確認します。
Running 状態で、ボタンの左側のア
ニメーションが動作します。
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